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Introduction
The field of English language learning is at the forefront of the Artificial Intelligence (AI) revolution 
that is currently in full swing. Machine Learning algorithms have been used to train machines with 
huge amounts of data. Every month new applications are introduced, and what used to be cutting 
edge a few months ago has been replaced by a new version or superseded by new products. Or 
something that was free a few months ago, it is now behind paywalls.

Planned or scheduled obsolescence goes rampant in the big businesses. New videos about the 
impact of AI tools on traditional language learning are uploaded to YouTube at a frequency which is 
hard to keep up with. As a result, fierce competition is actively occurring between tech companies 
for market share, and there are very few resources that have not been monetized yet. In almost all 
cases, this monetization takes the form of fremium (free-to-try, pay-to-use).

We did a thorough market survey to identify open source and free language learning applications 
or educational software we could use in the Self-paced English Learning Tool. The survey found 
that there are many English language learning applications using the latest AI technologies. 
Technology giants, such as Google, Amazon and Microsoft have taken leading positions in this 
market, launching applications using neuronal networks, Machine Learning and Big Data. These 
applications have reached a commercial maturity with fees ranging from 0 USD/month at the entry 
level, with limited functionality or number of input characters for testing, all the way up to 
hundreds of USD per month for hundreds of customization parameters, such as voices, speed of 
reading, voice pitch, tens of languages and users.

The AI text-to-speech and speech-to-text or transcription applications have a central role within 
this market. These applications are especially useful and offer valuable support for individuals with 
visual impairment, dyslexia, ADHD or any other type of specific learning disability (SLD), defined as 
imperfect skills in listening, speaking, reading, writing and spelling.

Most of the latest developments in the AI language learning field occurred within the last few 
months and they were introduced after the Transnational Project Meeting in Matera, Italy on 19-20 
September 2023, where we presented a first draft of the self-paced English training tool. As a 
result of this explosive growth of AI tools, the TreasureHunt project consortium of partners 
decided to proceed to a slight modification of the learning plan outlined in the approved project 
proposal. 

The modified approach combines the mainstream Computer Based Training (CBT) methods, 
included in the approved proposal, with content contribution from the latest AI tools. The 
mainstream methods offer better control over learner assessment by means of closed type 
questions (multiple choice, true/false, match type, fill-in the blanks, etc). However, AI tools for 
English language learning, such as chatbots, can hold decent online conversations and are getting 
better every day. The AI tools provide voice-synthesized audio, and thus can improve listening skills 
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by exposing learners to multiple English accents, pronunciations, speaking speeds, intonation 
patterns and content variety. 

On the downside, AI English conversation tools are only available as mobile apps and on their paid 
versions1; they might not be available to all countries yet, and they are available only when there is 
an Internet connection. Recently, however, the tide is turning and there have been dramatic 
changes in ChatGPT, the leading Large Language Model (LLM) AI tool. As of 22 November 2023, 
voice control capabilities, available only to paid subscribers back in September 2023, were made 
available to all users of the tool.2 

These changes have led to the decision to upgrade the self-paced tool with LLM tools, such as 
ChatGPT, Bing, Bard, etc. and solve the problem of limited teacher-learner interaction or lack of 
communication partners for practicing. Consequently, the AI tools added to the training content 
bring the TreasureHunt project at the forefront of technology and certainly generate great future 
possibilities.

Too much AI, however, is no good. A few years ago, the Greek Ministry of Employment made the 
mistake to trust Machine Translation without proper human supervision. The 193 million EUR 
scandal3 that shook the entire Greek government, was discovered accidentally by a few English 
words transliterated to Greek by machine translation, and resulted in a major blow to remote 
learning and vocational training through private vocational training institutions (KEK) of 
questionable quality and integrity maintaining clandestine connections with higher government 
officials, and led to the resignation of the Minister of Employment.

Recently it was discovered that language learning and memorization can be improved by using 
traditional tools & methods, such as paper and pencil, to write down information. It seems that the 
movement of pencil on paper helps creating new paths and associations among neurons that help 
store more information. Proponents of the new view point out that AI triggers the brain to act in a 
use-it-or-lose it way, and may become lazy in memorizing information. For example, the launching 
of smartphones capable of storing hundreds of telephone numbers in memory removed the need 
to remember telephone numbers; habits and tools such as keeping handwritten telephone 
directories, rotary telephone card holders or Marbig telephone list finders have become obsolete. 
As a result, today nobody remembers more than 2-3 telephone numbers, compared to tens of 
numbers before the new technology.

The take-home lesson about AI is 

do not trust the machine, and always check answers4 

This is a standard warning that every AI or “bot” has on its main page.
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Needs analysis
The conducted needs analysis was based on the following requirements5:

“...first identify exactly what someone working in the specific context 
actually does in their job…”

“...Sometimes this can be done through questionnaires but probably the 
best way to go about it is to observe real working situations. It’s easy to 
tick boxes in a questionnaire to say what you think you do but, in fact, 
you may not realize all the other things you do as well. Things that an 
impartial outside observer will notice.”

Agritourism business survey
After identifying the target audience (see Target groups,  below), the TREASUREHUNT project 
partners prepared and sent out structured questionnaires, conducted face-to-face interviews in 
each of the five countries participating in the project, visited many agritourism farms, and 
conducted on site observations and exchanges with the owners during Transnational Project 
Meetings (TPMs).

The following places were visited during various TPMs within the TreasureHunt project context6:

1. Tiraholm Fishfarm, Sweden; Farm Tour; presentation by Malin Ekwall & Juha Rankinen; 
English, Q&A

2. Skullaryd Moose Park, Sweden; Farm Tour; Eric Öster; English, Q&A

3. Cow farm, Sweden; Farm Tour; owners speaking Swedish; interpreted; Q&A

4. Karaiskos Farm, Volos, Greece; Farm Tour; owner cooperating with third party speaking 
English; Q&A

5. Bellos Farm, Agios Dimitrios, Mt. Olympus, Greece; Farm Tour; owner speaking Greek; 
interpreted; Q&A

6. L’ Albufera lagoon, Valencia, Spain; boat tour; boatmen cooperating with English speaking 
guide; Q&A

7. Local bakery, Matera, Italy; Lunch with local delicacies; history of business, recipes & local 
traditions for bread making; interpreted; Q&A

8. Masseria La Fiorita, Matera, Italy; Farm tour; food preparation using local recipes; owner’s 
daughter speaking English; Q&A
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9. Alpaca Farm, Pelles I Sunnaryd, Sweden; owner’s English-speaking wife Lisa gave us a farm 
tour, spoke about activities on farm, alpaca keeping, local customs and traditional coffee-
boiling, products sold; Q&A

10. Öströö fårfarm, sheep farm, Sweden; English speaking owner Kristian spoke about the 
history of the business, “Customers paying to hear me explain my job”, the two sales stands 
with home-made products, increasing sales during the Covid-19 epidemic, the lamb-safari 
ride, and slow ramping up of the business; Q&A

11. Erikson Cottage, Sweden; run by English-speaking sisters in-law Elisabeth and Katarina, 30 
ha forested family property, prepared sour dough for pizza making demonstration and 
hands-on experience (made our own pizzas), nature-houses in the property; Q&A

12. Casal Dragone, Matera, Italy; family business of two sisters and one brother, English 
speaking Angela gave us a farm tour, spoke about family vineyards and wine-making, local 
food items, cooperation with other local food producers for food procurement; Q&A

In each of the above visits, owners spent 90% of the time interacting (speaking and listening) with 
visitors. The subject was mostly on farm business background, farming activities, etc. and the 
vocabulary was structured mostly on the farm tour.

Survey weaknesses
1. Small sample size both in number of respondents and countries.

2. Little information about the other linguistic skills (reading, writing). 

3. No information collected about pronunciation and accent or proper language use.

Conclusions
Despite the survey weaknesses, the following conclusions can be drawn from the needs analysis.

1. In all cases, the farm tour was storytelling about the business.

2. All communication, business presentation and Q&A sessions were held in English either 
directly with the owner or through an interpreter.

3. English is essential for any agritourism business for presentation and promotional purposes.

4. Whereas oral communication (speaking and listening) is handled adequately, written 
communication (reading and writing) is expected to present serious problems.

5. Vocabulary was rather narrow, but sufficient for describing the focus of the agritourism 
business and for a farm tour, including farm animals, plants, cultivation methods and food 
recipes, vineyards cultivation, wine making and tasting, etc.
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6. From a wider perspective, there is a severe problem in agriculture of the EU. The younger 
generation does not want to stay and cultivate the land. Young people we saw in some 
farms stayed because the property belonged to the family for four generations (Tiraholm), 
or they were just self-motivated to stay (Skullaryd; Karaiskos Farm).

Facts & Stats
 Humans have short attention span not exceeding 8 minutes. 

 Average human attention span has decreased from 12 minutes to no more than 5 minutes7. 

 From 2014 to 2019, human attention span has decreased from 11 seconds to 8 seconds, 
putting humans below goldfish.

 According to studies, the average millennial picks up the smartphone 150 times a day. This 
over-dependence on tech is known as technology addiction.)8

 People check their phones every 12 minutes 9

According to “the treetop therapy”10:

 Most popular articles on the Internet have an average reading time of 6-8 minutes.

 Average attention span of Gen Z individuals is about 8 seconds, compared to 9 second 
attention span of a goldfish, probably due to many distractions surrounding humans.

 The average attention span of a teenager is 32-48 minutes.

 The average audience attention span is 8-10 minutes.

 An office worker will check their email box 30 times every hour. Young individuals, even 
more frequently.

 The average webpage visit lasts less than a minute, and users often leave webpages in 10-
20 seconds.

Thus, learning activities in this Study Guide are organized in learning bursts lasting no more than 8 
minutes each and thus several chunks (see Chunking, below) can fit in one hour.

- 16 -



Target groups
Aspiring agritourism entrepreneurs

Age: ≥ 17 years old

Assumptions
1. Entry-level standards for the course: Learners at the B1/B2 level of English of the Common 

European Framework of Reference for Languages.11 If in doubt, test using The Oxford 3000 
list of most important words to learn English, from A1 to B2 level.12

2. No teacher presence in a classroom environment. Learning coaches stay on the sidelines as 
academic advisors and to verify learner progress. 

- 17 -

Figure 1: English is a weird language 



3. Learners are the masters of their learning. They cooperate with learning coaches for 
advising, but the burden of learning is entirely on the shoulders of learners.

4. Learning coaches have authored the training material in each Module and provided input 
for the Educational Games (https://treasurehunt-games.oikothesis.org/). Learning coaches 
have prepared the sample tests, selected the basis of the Educational Games both for 
practice and self-assessment. 

5. UK English was selected as the language of the training material. However, most of the 
information available on the Cloud, and especially the audiovisual material on YouTube, 
together with the recent explosive growth of AI tools and language-learning commercial 
applications, is predominately in American English. Abundant material is also published in 
other English versions, pronunciations, accents and intonations from countries, such as 
India or Australia, and even by non-native English speakers. This material was not excluded 
for not being strictly UK English; instead, it was included, whenever necessary, to augment 
learner exposure to other versions of English. 

6. Five-day weeks and 6-hour working days were assumed as standard.

7. Average speaking speed of about 150-180 words per minute, and possibly 190 words per 
minute; short bursts of up to 250 words per minute possible when reading something.

8. Free and open-source software used throughout this training guide, although tools behind 
paywalls have been mentioned occasionally.

9. No learning disorders, disabilities, etc.13

Self-study guide philosophy
This Self-study Guide contains many links to other resources, such as YouTube videos, webpages, 
web apps, etc. This wealth of information provides a good opportunity to expose learners to 
diverse material in a live form and thus to practice their language skills. Users may replay videos or 
parts of videos that might be at a high speaking speed, and thus difficult to understand.

If learners have trouble keeping up with the speed or pronunciation or accent of the speaker, they 
can get help by clicking on the Subtitles/Closed Captions icon (CC) on the YouTube video to have 
the subtitles in English. This will enable learners to sharpen their listening and reading skills. If 
learners continue to have trouble even with subtitles displayed, they can turn on the translation 
feature for the video.

Warning: activating the automatic translation mode may be beneficial in the short run, but might 
become detrimental for your overall performance as learners’ brains become more lazy and they 
study less. Therefore, it is recommended that learners exhaust all other possibilities before clicking 
on the Subtitles/Closed captions icon.
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Learners may stop, resume or replay each video as many times as they want.

The above learning scheme covers fully the allocated time to learning and does not leave room for 
spare time activities. All time is invested in mastering the material, and left over time is used to 
repeat the material.

Learners in charge of their learning
In a self-study environment, learners will be in charge of their own learning. 

Like Schrödinger’s cat in Quantum Physics, Learners will be at both ends of the learning spectrum: 
they will be teachers of themselves, and actual learners at the same time.

It is a difficult mission that requires commitment and responsibility; most importantly, requires 
active learner involvement instead of passively receiving information. 

Success is not guaranteed: only those hard-working learners rising to the occasion will be able to 
shine. Most of the learners are used to receptive language skills and learning and it might take 
some time to get used to the new learning model.

Free virtual classroom platforms
Visit https://www.edapp.com/blog/top-10-virtual-classroom-platforms/ 

Addictive learning
Can learning be addictive? The answer seems to be a resounding YES.14

The ultimate goal of any educational system must be to make learning addictive.

Watch the video How to Make Learning as Addictive as Social Media15 from Luis Von Ahn, the 
founder of Duolingo, a 300 million user language learning platform. In the video, Von Ahn provides 
some hints on how Duolingo manages to engage learners by sending them messages about 
keeping up with the English learning lessons. Most of the things that involve repetition, can be 
gamified. 

To reach addictive learning, teacher enthusiasm, teaching style and motivational skills are 
essential. In self-paced courses, however, the presence of learning coaches and thus teacher-
learner interaction will be limited. It may take only a few carefully selected words by the teacher to 
motivate a learner to study, assuming that the teacher has a good knowledge of the learner 
personality. This is an important topic on any learning/teaching environment, and not just in the 
agritourism field.
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The ultimate goal of the Educational Games is to make learning a habit, self-feeding and 
sustainable. How long does it take to form a learning/studying habit? Opinions diverge: published 
studies claims that it takes from 66 days to 10 weeks to build a health habit of going to the gym.16. 

Our personal experience from birdwatching field trips with students is that it takes less than 10 
hours in the presence of a highly motivated teacher for learners to get hooked to bird 
identification. In contrast, it takes less than an hour to get hooked on playing some video games for 
fun. By extrapolation, it is expected that in a self-study English learning environment, highly 
motivated learners will form a study/learning habit within a couple of days of full-time studying, 
whereas less motivated learners will need a few weeks to develop a learning habit. 

Self-paced study

Definition
Learners set and proceed at their own pace, i.e. they can work and complete the phases of the 
project; set deadlines within a pre-defined time window agreed with the learning coach; practice, 
review, assessment & take final evaluation test – using Computer Based Learning, Ed Tech tools 
and AI methods minimizing educator intervention.

Resembling Independent Study (see The origins of self-paced courses below)

The origins of self-paced courses
Over forty years ago, U.S. academic institutions recognizing the fact that despite the long lists of 
offered courses Universities cannot cover all academic needs of learners, started offering 
“independent study” courses. These were flexible, one-semester, usually one-off courses, although 
some of them could be repeated for credit, each worth up to three academic credits aiming to 
cover special academic needs of interested learners. The academic needs could be a topic of 
special interest to the learner not covered by any of the regular courses listed in the Academic 
catalog. 

Self-paced courses are often reserved for graduate students working on their dissertation research 
and provide a way for in-depth search of a specific dissertation question. At the beginning of the 
semester or earlier, interested students meet with an academic advisor agreeing to start the 
project to discuss the details, such as to prove the need for taking such a course, the subject to be 
covered, whether the material differs substantially from any other offered course, to set deadlines 
and deliverables, the amount of work involved (books or papers to be read, output volume or 
number of papers, reports or essays to be written, length of reports, etc.). Throughout the 
semester, students meet regularly with the advisor to seek advice, if needed, and to make any 
schedule amendments if necessary. Deliverables include a number of research or literature review 
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papers or essays, each handed-in by the set deadline, assessment and faculty feedback to the 
learner.

Self-study guide layout
The Self-Study Guide is divided in three parts.

Part I is the General Part is the theoretical part and it is mostly addressed to educators. It provides 
the necessary background information on the origin and evolution of self-study courses, the needs 
for developing English learning for agritourism, and general guidelines on how to coach learners in 
a self-study environment.

Part II describes the Learning Process and it is addressed to intermediate level learners. It includes 
the bare minimum information, tools, resources, methods, examples and educational games 
learners will have to use in preparation for taking the TREASUREHUNT project Evaluation on the e-
learning platform (https://edu.treasurehuntproject.eu/modules). Learners taking Part I will 
practice with the material provided as is; no other learner action is required, for example to 
prepare exercises or repurpose the training material for new exercises/games, etc.

Part III comprises the Appendices and it is addressed to educators and advanced level learners who 
want to learn by doing. It contains chapters, such as Web searching, Language learning utilities, AI 
enhancements, Good writing practices, etc that are supplementary to English language learning 
and agritourism. It is an immersion learning environment in which learners build their own practice 
material (exercises, games, etc) using free and open source tools downloaded from the web, and 
based on PR4: A TRAINING PACKAGE ON AGRITOURISM 
(https://treasurehuntproject.eu/download/pr4-training-package-on-agrotourism/) and practice 
before taking the Evaluation. It requires some technical skills in CBT, but also provides the freedom 
to select and develop the building blocks of learning the 4+1 Linguistic Skills, such as text excerpts, 
closed-type exercises, audiovisual material, and attempts to explore the use of AI for language 
learning.

All three parts are open to and accessible to the public from the TREASUREHUNT project website 
(treasurehuntproject.eu).

The 4+1 linguistic skills
As it was mentioned in the Conclusions section above, communication skills include:

Emphasis on speaking and listening

Writing and reading are also essential, but are used less frequently and may require additional help
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Vocabulary skills were not scouted specifically.

Table 1: Broad learner objectives by linguistic skill and usage

SKILLS LEARNERS MUST BE ABLE TO USAGE

Listening Listen and understand standard native English content Be a good listener

Speaking Express themselves clearly through spoken language Storytelling

Reading Read and comprehend text that is not too technical RTFM

Writing Express themselves clearly in writing 5W+1H

Vocabulary Master and use the 595 agritourism terms effectively Web search

Grammar?
English Grammar was not included in the training material developed for the TREASUREHUNT 
project.17 This decision was made for three reasons:

1. People do not use Grammar consciously when they speak or listen. In other words, they do not 
stop to think how to formulate the proper tense of a verb, or number or declension of a noun or 
adjective, etc. If they do that, they lose the core meaning of what they want to say. Rather, people 
receive and produce information and delegate Grammar processing to the subconscious. That’s 
perhaps the main reason that study of Grammar is being dealt with in the first stages of English L2 
learning. Fortunately, English Grammar is not too difficult as in some other languages, so early 
learners can handle it relatively fast.

2. It was assumed that the target audiences have a sufficient knowledge of English language and 
Grammar (B1/B2 level of CEFR) (see Assumptions, above).

3. Usage of Grammar for web searching. Even before the advent of AI, search engines were error 
tolerant; that is, the outcome of the search was not affected even if people enter something that 
was not grammatically correct or contained spelling errors, etc. In the unusual case that a search 
engine does not understand something, it will suggest a correct alternative such as “You searched 
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for… Did you mean…”. Learners may want to experiment with web searches constructed from 
disjointed lists of keywords and compare them with searches using proper English.

This decision resulted in leaving out topics such as: English articles, English expressions, Irregular 
verbs, Phrasal verbs, Prepositions, etc.

In other language applications, such as writing, however, Grammar is essential. But, there are 
extensions, applications, etc that can automatically handle Grammar and suggest corrections while 
entering the text (see .Grammar and vocabulary checkers, below). 

Caution:  always check the results of the autocorrector and other grammar-handling applications.

And lastly, there is a variety of freely available tools, add-ons and extensions for any word 
processor application that can correct spelling, grammar and syntax errors on the go.

Consequently, grammar and syntax are considered topics beyond the scope of this Self-Study 
Guide and should probably be left for English Literature majors.

Learn a language like a baby
The approach that will be used here reflects how babies learn to communicate. 

Briefly, babies listen to and focus on the sounds around them, vocalize and produce 
incomprehensible sounds, discover how to control their vocal chords to produce specific sounds 
and eventually form words, followed by associating word sound with concepts, and putting the 
words in order to convey compound meanings. 

The main point of successful language acquisition is that babies do not feel ashamed to speak. 
They feel no guilt or inhibition to make weird noises, mistakes, because probably they are unaware 
of mistakes and errors. They start experimenting from the very simple ba, ma and da sounds; this 
is probably why the words ‘mother’ and ‘father’ in many languages include the above sounds; for 
example, dada, daddy, dad, mama, mamma, mam, maman, moar, babo, баща, or papa, papi, pop, 
etc. 

Babbling begins shortly after birth, with vocalizations involving flexing of the throat muscles and 
contraction of the vocal chords, and continues to the age of 12-18 moths. Noticeable differences 
occur between boys and girls with the latter having a clear head start in language development, 
but the end point being the same after a few years.

Babies lack shyness and inhibition resulting from fear to be exposed or making mistakes. Babies are 
totally ignorant of what people have to say about their language skills or lack thereof, and continue 
to speak the way they think is right or funny. In fact, people find baby language errors charming, 
funny and cute; that triggers feelings of affection and the urge to help babies learn faster. 
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Later on, in elementary school, children learn to read and convert spoken language into written 
symbols (letters) and vice versa. Interestingly, grammar and syntax are nowhere to be found in the 
above sequence and appear much later, actually forced upon schoolchildren, at school age.

Although the borders between the onset of the 4 + 1 linguistic skills often are blurred, it seems 
that receptive (listening and reading) and productive (speaking and writing) skills are intertwined. 
More specifically, babies obtain skills in the order: 

Listening > Speaking > Reading > Writing

The above biological/chronological sequence to language learning has been recently endorsed by 
the British Council as a helpful model for teaching English to adult learners.18

Moreover, skill differentiation between receptive and productive ones is a superficial and 
anthropomorphic and disregards the fact that skill learning occurs simultaneously; for example, 
listening and vocalization come much earlier in childhood than the development of reading and 
writing skills. People that did not have a formal education, and thus were not taught reading or 
writing or grammar skills, can communicate remarkably well in everyday spoken language. 
Interestingly, some of these people were self-taught in reading and writing to a satisfactory level. 
Vocabulary building, on the other hand, is a process running in parallel and in a positive feedback 
loop with each and every one of the four skills. 

Grammar and syntax seem much more complicated skills and probably remain elusive for many 
native-English speakers too. It is commonly suggested to develop a feel for grammar and proper 
word order instead of being preoccupied with learning every single rule about them;19 sometimes, 
paying too much attention to Grammar and syntax can have negative effects and can inhibit 
language learning. 

Learners do not have to be at the early stages of their lives to learn English using infant-derived 
methods. As recent research has shown20, learners starting to learn English much later in life can 
reach incredibly high levels of English proficiency21, although some researchers claim that infancy 
might be the critical period to learn new languages.22 There are even claims that adults are better 
than children in learning languages.23

It is acceptable for people not to speak perfect English as long as others will be able to understand 
them. In fact, native-English speakers are very permissive and find it interesting to listen to a 
foreigner speak. Neither do non-native English speakers need to devote too much time for 
perfecting their English. After all, 

perfect is the enemy of good and 

beauty is in the eyes of the beholder.

There are, however, fundamental differences in First Language Acquisition (FLA) vs. second 
language acquisition (SLA). Some sources claim that FLA is instinctive24, meaning FLA is like writing 
on a clean slate and thus, FLA is probably easier and faster than SLA. Other studies claim that 
native language may interfere in learning a second language, and thus may have an inhibitory 
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effect on SLA.25 Still others claim that language learning ability decreases dramatically after the age 
of 3-7 years.26 Other personality traits accounting for differences in FLA vs. SLA include personality, 
culture, motivation, mother tongue, etc.27 On the other hand, studies claim that SLA usually takes 
place at an older age; thus, the brain has been trained to receive and process information, such as 
language learning, and this results in increased learning capacity.

Consequently, this self-study guide follows the same order as in baby learning the 4+1 linguistic 
skills (listening, speaking, reading, writing and vocabulary), whereas the differentiation between 
receptive and productive skills, although useful in some cases, will be ignored. 

Methods to learn English as a second language
See PR4: TRAINING PACKAGE ON AGRITOURISM, p. 135

Learning apps & tools
For the theoretical part, refer to Learning apps and Learning Tools in PR4: A TRAINING PACKAGE 
ON AGRITOURISM, pp. 135 - 136.

Download and install the free and open source Hot Potatoes suite28. 

For more information on Hot Potatoes, see Hot Potatoes suite for interactive exercises, below.

Consult the Help facility of each of the 5 Hot Potatoes applications.

For tutorials on how to use the software, visit https://hotpot.uvic.ca/tutorials7.php.

For an extended list of Hot Potatoes features, visit http://www2.gwu.edu/~francais//.

For vocabulary studying, see Spaced repetition, below.

A detailed list of tools is provided in Appendix 2 – Language learning utilities, below. Consult the 
Help facility and Tutorials on the web for each tool. 

For instructions on how to build your own exercises using the Hot Potatoes suite, see “How to 
construct your own exercises and tests”29

Serious fun
This ain’t no party
This ain’t no disco
This ain’t no fooling around
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- Talking Heads

Learning with no fun is no learning.

Fun and games can be very serious learning resources and lead to spectacular results.

According to a recent study, 91% of learners value fun in learning.

Ask yourself the question: What other learning method am I going to use if I don’t find fun in 
learning?

Self-chosen learning is fun; learning is the reward young animals get for being curious. This is what 
keeps them exploring and learning.

Learning in a school environment, however, is hard. Avoiding or minimizing these hardships is 
probably the ultimate motive of the TREASUREHUNT project, which was designed to elicit 
maximum learner involvement.

Obviously, learning remains the focus and distractions, such as gaming, should not interfere to 
shift the balance from learning to playing. 

Due to the limited learner-educator interaction, we have introduced the Educational Games for 
each one of the 4+1 linguistic skills, at the Intermediate Learner Level. These games were 
developed based on strict standards (see Development principles, below). For the Advanced 
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Figure 2: The benefits of having fun in learning

(courtesy of: https://www.growthengineering.co.uk/fun-in-learning/)

https://www.growthengineering.co.uk/fun-in-learning/
https://www.youtube.com/watch?v=DYT4KgsR-V0


Learner Level, we have tried to cause even more learner involvement and experimentation with 
the learning material.

Challenges and how to respond

Lack of learner motivation
Lack of educators imposed by the self-paced environment – Fortunately, AI technologies have 
become widespread and can alleviate the problem (see Chatbots for conversation practice, below.)

To cope with the lack of educators, TreasureHunt project learning coaches (project partners) will 
have to plan in detail the self-testing and evaluation process. To accomplish that, learning coaches 
will have to provide as much Machine Learning as possible, that is train the computer by providing 
interactive and self-correcting tools for English learning.

Procrastination
Bridging the gap between receptive and productive competence 
(https://www.cambridge.org/elt/blog/2015/08/27/bridging-gap-receptive-productive-
competence/)

Proposed learning plan
The proposed learning plan for each of the 4+1 linguistic skills is based on PR4: TRAINING PACKAGE 
ON AGRITOURISM30 and is organized as follows:

LEARNING OBJECTIVES

SET SMART GOALS

STUDY

End point (compared to SMART goals)

Near: over 90% of set SMART goals on 4 trials spaced 2-3 days apart

Far: below 75% of SMART goals

PRACTICE

Daily schedule

Tools
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Methods

Active/Hands-on learning (learn-by-doing)

Test development 

Deliverable: Table of ... skills educational games development

Desktop environments

Smartphones

Performance monitoring

Learners prepare their own performance monitoring plan depending 
on the linguistic skill; for example, keep track of:

 number of words in the original text

 how many times did you have to listen to the text until you 
got a good handling of it?

 how many minutes did it take you to read through the text?

 how many words did you read? 

 how many words did you omit or skip or forget to read?

 how many mistakes (mispronunciation, etc) did you make?

 how many times did you stop and restart reading a sentence?

 how would you rate your 
listening/speaking/reading/writing/vocabulary performance?

 assuming an average native-English speaker reading speed of 
190 correct words (= total words – omitted - 
mispronunciations) per minute, was your reading satisfactory?

 ...



Self-assessment

REVIEW

EVALUATION
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PART II – LEARNING 
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Introduction
By definition, this Self-Study Guide will present only the minimum information. As a result, in many 
cases the information presented is in bulleted list format. Of course, interested parties are 
welcome to research and enrich the training material on their own. A more detailed online version 
might be prepared after the end of the TREASUREHUNT project.

Gather your resources

Your superpowers
See PR4: A TRAINING PAGKAGE ON AGRITOURISM, p. 132.

• MOTIVATION vs. OBSESSION31, 32 – intrinsic vs. extrinsic motivation debate33

Good requires motivation, great requires obsession

• COMMITMENT

• DETERMINATION

• COURAGE 

• SENSE OF DUTY

• PERSISTENCE

• IMMERSION

• PRACTICE

- 30 -



The TREASUREHUNT project training material

The website
The home page of the TREASUREHUNT project (https://treasurehuntproject.eu/). Includes the 
purpose, aims and objectives, News and Newsletter, as well as the Partnership of the project, and 
serves as a link-catalog to onsite and offsite Product Results.

PR4 – Training package on agritourism
PR4: A TRAINING PACKAGE ON AGRITOURISM (https://treasurehuntproject.eu/download/pr4-
training-package-on-agrotourism/) is the starting point of studying for each of the 4+1 linguistic 
skills and provides the theoretical background for the project.

The Package was developed and is addressed to entrepreneurs who are thinking of starting their 
own medium-sized agritourism business (PR4: TRAINING PACKAGE ON AGRITOURISM, p. 3). 

The text outlines a program designed to equip aspiring agricultural entrepreneurs with soft skills, 
guidelines, methodologies, tools, topics, and competences. The goal is to help agritourism 
entrepreneurs understand and benefit from the synergy between agriculture and tourism, build 
their soft skills and enable them to establish successful and sustainable businesses (approved 
TREASUREHUNT project proposal, p. 74).

The Package includes six Modules with three Lessons each. Lessons use a common layout with the 
following sections:

1. Learning Outcomes – what learners will have accomplished after completing the Lesson,

2. Did You Know? – some introductory facts to trigger learner curiosity,

3. Let’s get to the point! – the body text with the main content o the Lesson,

4. Time for exercises! – mostly closed-type exercises based on the body text with answers,

5. Case studies, interviews, and Real life examples –  self-explanatory.

The e-learning platform 
The e-learning platform (https://edu.treasurehuntproject.eu/modules) is as an augmented 
implementation of the PR4 and the exit point from the TREASUREHUNT project learning 
environment for learners who sign up and complete the interactive tests posted. The platform 
provides Profile customization, and allows networking with users sharing similar interests in 
agritourism.

All PR4 training material has been posted online, by Module and Lesson within Module. Full, rich 
text available with working links, etc. Organized in the same layout and standards as the PR4: 
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TRAINING PACKAGE ON AGRITOURISM (see above), the e-learning platform is essentially a transfer 
of PR4 to .html format. Can be used for listening practice provided an appropriate, good quality 
text-to-speech browser extension or add-on, such as Read Aloud: A Text to Speech Voice Reader, is 
installed.

Users wishing to receive their attendance certificate must sign up to the platform, study each 
Module, and complete the Exercises at the end of each Lesson. Progress is monitored and 
displayed as percent completed. Learners can interrupt their learning flow, and return at a later 
time, without losing any of their previous work. Test taking can be repeated as many times as 
required for successful completion.

Multimedia glossary
The TREASUREHUNT Glossary (https://treasurehuntproject.oikothesis.org/) is an attempt to 
eliminate language barriers by bridging the terminology gap in the agritourism field.

The Glossary can be used as a standalone application or in combination with the PR4: TRAINING 
PACKAGE ON AGRITOURISM. Consequently, the Glossary is considered as the most important 
TREASUREHUNT Project Result, as it provides the key to unlock web searching AND for discovering 
a wealth of information and business opportunities in agritourism and elsewhere. For an effective 
web search algorithm, see Appendix 1 – Web searching.

The Glossary provides a set of 595 agritourism-specific terms translated into the six project 
languages and, thus, all pair combinations of the six languages. Any of these pairs of translated 
dictionary terms can be used as glossaries for translations.

The glossary contains the definition of each term (in English), the pronunciation in British English, 
and the translation into each of the five languages of the TREASUREHUNT project. It is indexed 
(searchable) by each one of the six project languages (English, Bulgarian, Spanish, Swedish, Greek 
and Italian), and thus it can be used for translation in any language combination (e.g. Spanish to 
Swedish, Bulgarian to Greek, etc). 

The glossary is comprehensive but not complete and more terms or languages could be added in 
the future. It was developed, however, by humans for humans and was checked by humans; thus, 
it offers a reliable service for which AI is not very well trained yet; therefore, the Glossary 
represents an example of human work enhanced by AI in a balanced coexistence.

Educational Games
The Educational Games play a crucial role in the TREASUREHUNT project. 

In contrast to the stationary format of PR4 – Training package on agritourism, above, the 
TREASUREHUNT project Educational Games (https://treasurehunt-games.oikothesis.org/) provide 
an attractive, dynamic, interactive, multimedia and engaging environment by Lesson and Module.
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They are the tool where learners can:

a) practice their 4+1 Linguistic Skills, 

b) monitor progress,

c) take self-assessment tests34, 

d) get acquainted with the types of questions in the Evaluation,

e) review their knowledge,

f) diagnose weaknesses, 

g) decide whether any further action is needed

h) fill out any remaining voids in their knowledge, and 

i) devise a test-taking strategy before taking the Evaluation (see The e-learning platform , 
above).

For all these reasons, learners are encouraged to make the Educational Games a regular part of 
their study before taking the Evaluation (see Figure 10, below).

The Educational Games follow the sample format provided in the Time for exercises! section of PR4
– Training package on agritourism, above. 

In general, gamification provides various versatile tools that can be adapted to a variety of topics 
ranging from Environmental Science to History. More specifically, the TREASUREHUNT project 
Educational Games provide numerous question types and can link to audiovisual and multimedia 
material. Each Educational Game is usually based on a previously entered database comprised of 
several questions and/or terms. The order of questions is randomized each time a test is taken; this 
provides a dynamic nature, avoids “learning order effects”, and serves as a safety measure against  
academic misconduct.

Some game types have been used with impressive success in previous Erasmus+ projects, like the 
twin Tools for Skills and Tools for Skills Teacher Training projects35, to provide more engaging 
content and stimulate learning interest among learners. The gaming approach was an award-
winning training tool voted as the top training tool by a multinational group of educators in the 4th 
International Conference of Forestry Training Centers36.

A weakness, however, of most of the above publicly available word games is the limited 
customization, that is the capacity to enter the terms or words of a specific glossary or set of words 
once the games are posted online. For example, many online educational games do not provide 
the capability of inserting a customized list of terms, such as the TreasureHunt project glossary. 
Fortunately, however, there are many free and open source software, such as Crossword Express37 
comprising a variety of highly customizable learning games, such as wordsearch, wordweave, etc. 

The conclusion from the above is fourfold:  
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a) people are having fun playing word games as evidenced from the huge popularity of 
word games worldwide

b) some word games use cutting edge technology for improved learning results, 

c) educational games are powerful tools for addictive language learning, and learning of 
other skills too

d) word games are endorsed by major English language Institutions as effective language-
learning tools.

For all these reasons, Educational Games were developed for each of the 4+1 Linguistic Skills 
within each Module and Lesson of the TREASUREHUNT project. Game development followed a 
well-defined set of Development principles (see below).

Development principles
The Educational Games developed for language learning in the TREASUREHUNT project are based 
on the following principles:

1. They provide free games for user-friendly and effective learning.

2. They are agritourism-specific and based on the 6 Modules of TREASUREHUNT PR4.

3. Animation, fancy graphics, sound effects and special effects were unacceptable as they 
promote distraction.

4. The Games provide fast-track learning, as users can check their answer immediately 
without the intervention of third parties.

5. They contain closed-type questions with well-defined answers. This may seem 
counterintuitive, and it might be argued that closed-type questions do not allow learner 
critical thought development. Closed-type questions, however, is the most effective 
learning method in a self-study environment, such as the TREASUREHUNT project, as the 
method limits trial-and-error and provides immediate error-checking and correction. In a 
future embodiment or extension of the TREASUREHUNT project, more Educational Games 
could be added including open-type questions, but still operating within an environment of 
limited teacher presence.

6. They allow learners to learn from their mistakes, without being reprimanded or socially 
stigmatized.

7. Learners can learn at their own pace, and they are not being monitored or graded or 
exposed to a class environment. Therefore, they eliminate learning inhibitors, such as 
shyness or test anxiety or fear of failure in a classroom environment.

8. Practice anywhere, anytime and as many times as necessary.
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Materials & methods for game development
The Educational Games were developed by all TREASUREHUNT project partners, each of them 
being responsible for the Module authored in PR4: A TRAINING PACKAGE ON AGRITOURISM. The 
authors of the Self-Study Guide sent out to each Partner templates for selecting appropriate text 
excerpts from the PR4 Module each partner authored. Responses from Partners were collected 
and processed by our team and were converted to different closed-type questions/exercises using 
the Hot Potatoes free and open source software (see Hot Potatoes suite for interactive exercises, 
below).

The Hot Potatoes exercises were named collectively as Educational Games to make the material 
more attractive and engaging for learners.

Educational Game development included a series of additional steps, such as text-to-speak 
conversion including punctuation marks and recording in different playback speeds, text checking 
and simplification, providing alternative correct answers (e.g. “agrotourism” and “agritourism”), 
finding rhyming words, occasionally providing explanations for wrong answers, or answers 
accepted as correct although not including all missing words, finding and providing clues such as 
definitions, converting each one of the 595 glossary terms to audio using British accent, lists of 
glossary terms by lesson for Spaced repetition, (see below) etc.

Each Educational Game was originally planned for one Linguistic Skill only; however, there are 
more than one types of Educational Games per Linguistic Skill. During Game development, 
however, it became obvious that every skill included synergy with more than one skills. For 
example, in the Writing Skills Note taking game, learners will need to combine listening and writing 
skills, although there an effort was made during Game development to focus on writing skills.

Educational Games by linguistic skill
A total of 600+ Educational Games were developed in 17 game categories (see below), across the 
4+1 linguistic skills, the 6 Modules and 18 Lessons of the TREASUREHUNT project. More 
specifically, 

• 3 games for Listening Skills (Connections, Listen and fit and Listen Up)

• 3 games for Speaking Skills (Sounds Similar?, Rhyming words, Spot the not)

• 4 games for Reading Skills (Letter soup, Word detective, CluesO, Scripting)

• 3 games for Writing Skills (Spelling bee, Word safari, Note taking), and

• 4 games for Vocabulary Skills (TermID, Lord of the Words, Matchmaker, Crossword)

In this Self-Study Guide, the word ‘game’ means an activity which is entertaining and engaging, 
often challenging, exclusively designed for educational purposes.

Any of the 4+1 linguistic skills is not a single process; in most cases, each skills involves the 
interaction of two or more skills. For example, reading a book involves reading skills, i.e. the 
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association of written symbols in a specific order with concepts, objects, people, situations, etc. 
However, when someone starts asking questions to assess what the reader has understood or 
learned from reading the book, then a mixture of reading, listening, speaking and writing and 
vocabulary skills is involved. 

Developing a Game exclusively for a single linguistic skill would be counterproductive and 
practically impossible. In addition, each linguistic skill is an interaction involving more than one 
faculties (abilities), senses and cognitive processes. Consequently, all educational games involve a 
combination of skills. f

Strengths and weaknesses of training material
PR4 in text form; good for reading skills but not much help about listening skills

Missing audiovisual listening material – PR4 can be converted to audio

Social interaction –  missing to a large extent; however, AI tools offer alternatives

Despite its nice layout, occasional figures and icons, graphics, tables, links, references, and uniform 
layout across lessons, the PR4 material contains long and unattractive text; therefore, it is expected 
that learners will soon lose their interest and motivation38. 

In addition, young learners are not motivated to read and they prefer texting each other. Mature 
learners may have a busier schedule of daily activities, and they would prefer listening to the 
material while they drive or commute to and from work. Therefore, the text to speech conversion 
is probably an important aspect of the training material that needs to be developed.

Furthermore, although a table of contents is provided at the beginning of each Module, it is 
difficult to trace the main points of each of the three Lessons per Module. It is recommended to 
add a 10-15 point FAQ at the beginning of each lesson summarizing the main points.

From all of the above, it is evident that the material of PR4 needs to be upgraded and become 
more engaging for learners. The regular approach form making the training material more 
engaging includes the following:

Criticisms for the Educational Games
It has been said that the Educational Games are too tough for entry-level learners and that Games 
should be grouped by difficulty level.

It is true that some learners, especially the less experienced ones with English language, may find 
the Educational Games challenging. For example, in our agritourism business survey, we witnessed 
some senior citizens that managed to give their farm tour in English even though they never had 
any formal English education. And we were asked whether these senior citizens would ever be 
interested in opening the Educational Games of the theoretical part. We speculate that these non-
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native English speakers learned to speak English due to similarity of their native language (Italian) 
with English, and repetitive presentation of the farm tour. For them, the Educational Games will be 
challenging and probably they will never consult the theoretical training material in PR4: TRAINING 
PACKAGE ON AGRITOURISM. In contrast, the Games should not be too difficult for young B1/B2 
CEFR level learners. Learners wishing to invest their time and practice for the TREASUREHUNT 
project Evaluation part, however, will probably find the Educational Games quite useful.

It is wrong to believe that the Games are just for entertainment and learners at any level can wing 
them without preparation or study. The Games were not developed to be easy to take, because 
this would be defeating their training purpose; something very easy is not interesting and thus 
becomes boring. The Games were developed to stimulate learners to study English and the other 
soft skills mentioned in PR4: TRAINING PACKAGE ON AGRITOURISM necessary for an agritourism 
startup. 

The TREASUREHUNT Educational Games and the project training material pack a substantial 
volume of information which may be scary for some learners. This is a case similar to textbooks 
and reference material. Textbooks contain a wealth of educational material, even though some 
learners may never open them to study in a classroom environment or may use them sparingly and 
only for specific subjects. In a self-study environment, however, learners will need to use the 
training material and the Educational Games to study. One way to deal with the volume of 
information is by Chunking (see above).

The learning curve is not too steep, and it is not necessary to know all technical details about how 
the exercises work. What matters most is for the learners to commit to studying, practice and 
create associations between the theoretical and practical part. 

Lastly, grouping the Educational Games by level of difficulty is an interesting proposition that can 
be only partially answered here. For multiple choice tests, for example, the number of available 
choices offers a preliminary difficulty criterion: the more available choices, the more difficult the 
test. Thus, a True or False question is easier than a Multiple Choice question with 4 possible 
choices, because each of the possible answers in the first case has a 50% likelihood of being correct 
by chance alone, compared to 25% in the second case.

An in depth assessment of test difficulty, as well as training material suitability for educational 
purposes, has worldwide application, but it is beyond the scope of the TREASUREHUNT project.

How to use the glossary to support translation in each 
of the 6 project languages
In recent years, great strides have been made in the field of Machine Translation and Natural 
Language Processing. Machine Translation has been at the forefront of AI in the last 20 years. 
Machine Translation (MT) is the use of Machine Learning (ML) methods for translating text or 
speech from one language (source) to another language (target) including the subtle differences 

- 37 -



that make each language unique. Machine Learning, in turn, is a subset of AI concerned with 
computer training, i.e. feeding data to computers and providing the processing algorithms, so that 
computers will perform tasks without explicit instructions.39 Applications of ML include Natural 
Language Processing, speech recognition and production, Machine Translation, predictive 
analytics, etc.

However, it is not certain today whether MT is a lifesaver or a plague. For example, Greek to 
English MT in Facebook gives a text that in many points is unreadable due to multiple errors 
stemming from computer failure to understand the source (Greek) language nuances. Without 
checking, the final text is borderline ridiculous and makes very little sense.–

Depending on the origin of source text, there are three types of translation items:

Documents
The following instructions refer to Microsoft Office on a desktop environment. It is further 
assumed that Microsoft Office does not have access to the Microsoft translation tool and hence 
the text cannot be translated directly.

Enter the text in Microsoft Word.

Break each paragraph to sentences. Use periods, semicolons, colons and/or any other punctuation 
mark appropriate as break points.

Edit > Replace > Find what: “.”, Replace with: “.^p”, Replace All.
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The procedure for breaking the text to individual paragraphs is shown in the figure below.
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Convert the text to a single-column table.

Table > Convert > Convert text to table; Number of columns: 1; 
Separate text at -> Paragraphs > OK
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Figure 3: The source text broken down to paragraphs using periods (.) as breaking points.

Some breaking points were omitted and sentences failed to separate, such as "...instructions. 
Applications of ML...". Some other points, such as "...i.e. feeding..." were identified as false 
positives and yielded separate sentences.
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Figure 4: The source text converted to table.



Add one column to the right of the table.

Table > Insert > Columns to the Right

To equally distribute column width

Table > Autofit and Distribute > Distribute Columns Evenly.
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Figure 5: A column added to the right of the English source text



The reason for converting the text to columns is because in a two-column format, it is easier to 
grasp and convey the meaning of each sentence, and to translate all text without missing any part. 

For the agritourism-specific terms, use the TREASUREHUNT Agritourism Glossary 
(https://treasurehuntproject.oikothesis.org/) and enter the translation of each sentence in the 
corresponding cell on the right column. 
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To eliminate the red underscore, set the language of the text to... (in our example, Greek) as follows: 

Select the right column, and

Tools > Language > Mark selected text as:  → Greek > OK
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Figure 7: The English to Greek translation as a two-column table.

The Greek translation on the right appears with red underscore because the language of the text 
has not been set to Greek.



Select the left column and delete it

Table > Delete columns 

Convert the table to text

Table > Convert Table to Text → Separate with Paragraph marks

and deselect the text (click outside the text).
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Figure 8: The bilingual text after setting the language of the right column to Greek.



Webpages
Download and install any translation browser add-ons, extensions, plugins, etc. 

Depending on the browser, there may be add-ons that provide translations from multiple engines 
for comparison.

Tip: For selecting the most appropriate add-on, consider the following: a) does it provide 
translation from and to the languages of interest, b) translation engine(s) used40, c) the number of 
users or downloads; be cautious about too few users or downloads, and d) user comments and 
ratings; usually more “stars” is better.

To translate the text, select the text on the webpage, right click and select Translate.

The quality of the translation varies with the target language; for frequently spoken languages, 
such as Spanish, Italian, Portuguese, Chinese, etc the translation is pretty good. However, do not 
trust the computer and always check the translation to make any required amendments or 
improvements.

Run a QA/QC on the translation output similar to the one above for Document translation.
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Figure 9: The translation converted to free text format.



Speech
To translate a speech in a desktop environment, make a recording of it first. 

Convert the audio to text, using one of the many fee speech-to-text-converter tools.

Save the text in a document file format (.docx, .txt, ..odt, etc)

Use a similar procedure as the one used for Documents translation above.

Translation using smartphones
Alternatively, you can do speech translation on the fly, using your smartphone.

Go to App Store, download and install the free Google Translate app, which can translate speech, 
conversations, text, or camera images in 100+ language pair combinations. Other features of the 
app include listening to the source text and the translation, copy and share the translated text, etc.

Benchmarking
To test the Google Translate app, we dictated the text

Welcome back my friends 
to the show that never ends
We’re so glad you could attend
Come inside, come inside

ELP; Karn Evil 9, 1st Impression, Part 1

to the Google translate free app downloaded from the App Store, installed on an iPhone 15, and 
we requested an English to Greek translation. The app transcribed flawlessly all words dictated, but 
transcription quality may vary depending on individual pronunciation. 

The translation result was “thumbs up”, meaning that the gist of the above verse was clearly 
understood in Greek and did not require any interventions to improve clarity.

We then asked the app to back translate its own Greek translation to English. The back-translated 
text was about 65% similar to the source English text. This is not a very good rating, but this is as 
good as it gets for this kind of benchmarking. It is not certain whether a bilingual human would do 
much better than that.

Learners are welcomed to experiment with translations and back translations in other language 
combinations.
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QA/QC
Do not be fooled by the seemingly good quality or the smooth appearance of the machine 
translated text. 

Never accept any translation without checking for quality and consistency.41 

When finished with the translation, use the Agritourism Glossary to double-check for correct 
terminology translation and translation consistency. Look out for errors such as translation 
inconsistencies, text duplication, transliteration, broken text segments, non-understandable 
phrases, disambiguation, terminology deviations, adaptation to the target language, etc.  

From the above it is concluded that translation engines may accelerate translation, but they are 
not to be trusted or run unsupervised.

How to use the training material to support English 
learning
The training material developed for this English for Agritourism Self-Study Guide was based on 
PR4: TRAINING PACKAGE ON AGRITOURISM. All the questions and answers developed for PR5 used 
the material of PR4 plus the Agritourism Glossary, which was in turn developed based on PR4.

The objectives of the two PRs, however, are quite different and should not be confused. 

PR4 objectives were to train people interested in developing agritourism-related soft skills and 
competences, such as communication, elements of a business plan, opportunities of business 
development, promotional, managerial and financial skills, and introductory language skills 
development. 

PR5, on the other hand, focused exclusively in developing a Self-Study Guide for raising awareness 
in English language learning, and provide young learners with the tools and training material to 
improve their English skills, which are essential for any agritourism business. The necessity of 
improved English skills was verified and reinforced following numerous on-site visits to agritourism 
businesses in all countries represented in the TREASUREHUNT project consortium of partners (see 
Agritourism business survey, and Conclusions, above).

As it was stated above, English learning was defined as acquiring or improving the Listening, 
Speaking, Reading, Writing and Vocabulary Skills (see The 4+1 linguistic skills, above). Therefore, 
the answer should include customized ways to use the training material for the 4+1 language skills.
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Human resources

Learning coaches
For the purposes of the TREASUREHUNT project self-study guide, the term learning coaches will 
collectively refer to teachers, instructors, educators, mentors, tutors, etc. and any other person 
responsible for sharing knowledge with learners. All of the above terms are used interchangeably, 
although there has been an effort to keep consistency. In turn, the term learner is used 
interchangeably with the term student. 

The mission of learning coaches is to motivate learners and make fine adjustments in the learning 
process so each learner will maximize learning performance and success. Learning coaches will 
always be available for learner advising.42 Learning coaches will be mainly involved a) in the 
beginning of the course to discuss the timetable and deadlines in cooperation with learners, b) to 
make sure that learners adhere to their study plan and deliver the set landmarks, c) in providing 
feedback on leaner progress and quality of work, and d) suggesting ways to catch up in case of 
deviations from the learning schedule. 

In the beginning of the course, learning coaches will cooperate with individual learners in drawing 
up a customized learning plan. From then on, learning coaches will assist each learner to keep the 
plan throughout the course (see How to use the training material to support English learning, 
above). 

Learning coaches will be responsible for selecting the parts of the learning timetable, the training 
material to focus on, for developing general study guidelines and tools, for preparing the self-
assessment and evaluation tests, and for providing the grading procedure used at the evaluation 
stage. 

Learners
Learners will act as teachers of themselves; they will prepare a study plan and proceed with 
studying and practicing. 

In a self-study environment, learners do not have to be physically present in class and they can 
work remotely from their own study environment. It is possible that learners will appear in school 
the first day to discuss with their learning coach, and will study remotely from home. 

Some learners may select a library study room, but this could be a challenging situation for 
language study involving audio playback, listening and speaking parts. On the other hand, a library 
study room may be a great venue for group learning and practice.

Unlike a traditional learning environment, where a syllabus applies to all learners in a class, and a 
teacher delivers often theoretical and boring lectures, learners are actively involved in designing 
and implementing their own learning plan and keep track of their own progress: depending on 
their workload of daily chores, learners draw up their own learning schedule within the provided 
period of 13 weeks for a 3-credit course, set deadlines by task, select when to study what, discuss 
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and refine it by themselves or with their learning coach, implement it and take self-assessment 
tests. In this way, learners take ownership of their learning path, and thus are highly motivated to 
complete it effectively and on-time.

Throughout the learning period, learners may consult with the learning coach about learning 
topics, methods, tools, resources, activities, learning weaknesses, remedial action, etc. 

After completing their studying, and whenever they think they have reached a good level of 
experience in the specific learning task, learners will have a chance to self-assess their 
performance and identify weak points that need further work. The self-assessment stage, 
implemented by playing the TREASUREHUNT Educational Games (https://treasurehunt-
games.oikothesis.org/), can be repeated at will.

Tools, tips & tricks

Hot Potatoes suite for interactive exercises
Follow the British Council recommendations43 and develop interactive activities, review sessions, 
quizzes, etc. to enhance listening, speaking, reading and creative writing skills.

Hot Potatoes44 is a freeware considered by many as the golden standard for making interactive 
exercises.45 

Hot Potatoes is a suite of six applications, JQuiz, JMix, JMatch, JCross, JCloze and The Masher, 
enabling users to create multiple choice questions, fill-in-the-blanks, mixed-up sentences, 
matching/ordering and short answers.46 

1. JQuiz enables question-based exercises, such as True or False, Multiple choice questions, 
short-answer questions, hybrid questions and multi-select questions.

2. JMix enables jumbled or shuffled-word-in-a-sentence or letters-in-a-word questions.

3. JMatch enables match-type exercises; in other words a list of items appears on one side of 
the screen and a list of possible answers appears on the opposite side. Learners have to 
match one item on the one side with one item on the opposite side.

4. Jcross enables users to make crossword puzzles.

5. JCloze enables fill-in-the-blanks exercises. Learners complete all answers before checking. 
Clues and hints can be included, but using any of them will negatively affect the scoring.

6. The Masher enables building linked units of material; for example, a series of Hot Potatoes 
exercises can be added together to make a single testing set.
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A minor drawback is that Hot Potatoes currently runs only on Windows and Mac is not supported. 
The html output, however, can be used directly on either platform, and anywhere on the World 
Wide Web.

Download Hot Potatoes from http://hotpot.uvic.ca/index.php#downloads and make your first Hot 
Potatoes test in 2-minutes or less (https://hotpot.uvic.ca/wintutor7/tutorial.htm # Hot Potatoes 7 
Tutorial).

Spaced repetition
See “Spaced repetition software”, on p. 60 of 47

Flashcards
See “How to make effective flashcards”, on p. 59 of 47, and

Anki
See “Anki”, on p. 61 of 47

How to make your own spaced repetition exercises 
See “Construct a deck of cards for studying”, on p. 61 of 47

Language learning utilities
For a more detailed list of language learning utilities, refer to Appendix 2 – Language learning 
utilities, above.

Prepare for study
What is your learning style? Are you a “visual” or an “auditory” learner? A morning or an evening 
person?

Find your study place
Find a quiet place free from distractions, where you will have exclusive access rights.48 

Be ware, though; some new findings contradict old wisdom; for example, alternating the study 
room may improve retention.49
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Set you SMART goals

(Specific, Measurable, Attainable, Relevant, Time-bound)

Suppose, for example, that an aspiring agritourism entrepreneur wants to acquire a good 
knowledge of the agritourism terminology. The entrepreneur does his/her thorough search and 
discovers the TREASUREHUNT project Vocabulary application (treasurehuntproject.oikothesis.org), 
which is comprised of about 595 English terms translated into five languages. 

The entrepreneur sets the following SMART goals for himself/herself:

“Within the next three months, I will have learned the 595 
agritourism terms of the TREASUREHUNT glossary.”

At first sight, the plan seems compliant with the SMART goals.

• It is Specific because it refers to a specific source material, the TREASUREHUNT agritourism 
glossary.

• It is Measurable because it talks about a specific number of agritourism terms (595).

• It is Attainable (doable) because it specifies that within about 100 days (about three 
calendar months), the entrepreneur will have learned 595 terms, or about 6 new terms per 
day, which seems like a manageable task.

• It is Relevant because the TREASUREHUNT glossary contains agritourism terms that the 
entrepreneur wants to master before staring his/her business, and

• It is Time-bound because it specified the ‘next three months’, and not just any three 
months from now to eternity.

Review/Revise your study goals
A closer look, however, might reveal several flaws and obscurities of the plan that need 
refinement:

1. When the entrepreneur/learner plans to learn 595 agritourism terms, in which of the six 
glossary languages (English, Bulgarian, Spanish, Swedish, Greek and Italian)? Which one of 
those language pair combinations does he/she want to learn? The default pair is English <–
> native language, but which of the two pairs does he/she actually have in mind? English -> 
native language or native language -> English? Or both?

2. What exactly does the entrepreneur/learner want to learn? Pronunciation (in English only), 
term translation from or to his/her native language, spelling, use in a sentence, definition 
(in English only) or something else?
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3. The specific plan talks about the next three months. When exactly are these three months? 
Has any provision been made for holidays, vacation or other non-business days over these 
months? 

4. Within any period of three months, there about 12 weekends (Saturdays and Sundays) or a 
total of 24 days, which is close to one calendar month. Will the learner be working on 
weekends too? Because if the learner does not plan to do so, there are only about 66 
working days left to learn the 595 terms. In other words, learners will have to learn about 
10 new words per day, which is almost double the initial workload of learning 5-6 new 
words per day.

5. What does the learner mean by ‘have learned’? How will the learner measure success and 
retention? By number of terms remembered? After how many days? Because it is well 
known that memory fades quickly. Namely, it is possible that at the end of the three 
months, the learner does not remember many of agritourism terms learned at the start of 
the process. So, how many terms should the learner remember after 5, 10, 15, 30 or 90 
days? Or six years?

6. Define success rate. What is the End point? What does success mean for the learner? What 
is the retention rate after a specific number of days? How many terms should the learner 
be able to recognize, translate, pronounce, write down or use in a sentence at the end of 
the three months? Or after one week?

7. How will learners accomplish the goal? Which methods and tools will they use?50 How do 
they plan to eliminate distractions and stay focused? How often and which tools will the 
learner use to monitor progress? Does the learner have any contingency plans (Plan B) in 
case something goes wrong? For instance, how will the learner deal with missed days of 
learning? Or what will the learner do to review and recall learned words and restore 
memory?

8. How many hours per day will the learner be working on learning the 595 agritourism 
terms? When during the day will these hours be? Will learning be full-time or part-time due 
to other work, family, other obligations, chores, etc. the learner will be doing on a daily 
basis? These are stress factors on the learner and may take a toll on learning.

All of the above issues, and possibly more, need to be addressed and answers given before even 
starting the learning process. Obviously, the plan will need to be refined and even more questions 
may result from the revision process. It is time well spent and worth the investment. The more 
thorough the learning plan will be, the smoother and more effective the learning process will be. 
The self-study plan review, however, should not become an overwhelming objective or an excuse 
for procrastination, and the learning action should start as soon as possible after the revision 
process.
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Table 2: Educational Games by linguistic skill.

Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives
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Ear training
Listen to a term and 
drag and drop it next 

to its written form

Provides ear training and improved capacity to distinguish sounds of 
individual terms and matching each sound with the written form of the term. 
Indirect association between spoken and written speech.

Li
st

en
 a

n
d

 fi
t Listening & reading 

comprehension 
improvement

Listen to a term and 
drag and drop it in 

the appropriate 
sentence

Similar to “Connections” but requiring listening comprehension at the term 
level and deeper understanding on how to use the term in a sentence.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives

Li
st

en
 U

p Listening & reading 
comprehension 
improvement

Listen to the full 
passage (no blanks) 

with breaks between 
sentences and read 
the corresponding 
text (with blanks) 

while listening. Fill-in 
the blanks from the 

terms in the 
dropdown menu

A more challenging variation of listening comprehension skills development; 
requires short-term training and connection between text and audio at the 
sentence level. Learners must listen to the audio recording of the text 
segment and identify each word and its position; simultaneously, read the 
text, recognize the words, identify the missing term(s), and fill in the blanks 
from the dropdown menu.
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si

m
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r?

Learning 
reinforcement and 

retention by 
association between 

sounds 
(pronunciation) of 

known words.

Find the homophone 
or rhyming word

No audio reference material provided. Learners must recall each term 
pronunciation from memory and look for sound similarity with either the 
entire (homophone) or the ending (rhyming) of the proposed answers. 
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives
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R
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m
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g 
w

o
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s

Associate sound of 
question term ending 

with endings of 
proposed answers.

Find the word with 
similar sounding 

ending

Similar to previous game (“Sounds similar?)”; focused on rhyming words due 
to scarcity of homophones.

Learners must look for sound similarity between question term and proposed 
answers (rhyming) endings. Slightly more challenging than “Sounds similar?” 
because learners must focus on the ending and ignore the first part of 
proposed answers.

Positive learning reinforcement and retention by association between 
sounding (pronunciation) of question term with sounding of known words 
endings.

Sp
o

t 
th

e 
n

o
t

Find difference in 
question term ending 

pronunciation with 
ending pronunciation 
of words proposed as 

possible answers.

Find the word that 
does NOT have a 
similar sounding 

ending.

No audio provided; learners recall the pronunciation of each possible answer 
from memory and contrast it with the question term to identify dissimilarity.

Learning by differentiating (negative association) pronunciation of question 
term ending from endings of known words.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives
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R
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M

Le
tt

er
 s
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u

p
o

r 
Le

tt
er

 s
p

ill

Reading fluency and 
comprehension 

improvement and the 
individual term level

Put the letters in the 
correct order to form 

a term

Learners must have studied the training material and become familiar with 
the terms of the agritourism glossary to the point where they should 
recognize immediately any jumbled term. The provided term definition gives 
a solid clue to the correct answer, therefore, making it easier for well 
prepared learners. If this in not helpful enough, learners may request a “Hint” 
to find out the next correct letter; if this is not helpful enough, iterate to the 
point where the learner can form the entire question term. 

Eventually, there is the “brut force” method, where learners apply all possible 
combinations of letters until they reach the answer. This, however, may work 
for short words, but it fails for longer words (more letters).

W
o

rd
 d

et
ec

ti
ve

Reading 
comprehension 

improvement at the 
sentence level

Put the words in the 
correct order to form 

a sentence

Similar to “Letter soup” but one level higher. Learners must be well prepared 
to make sentences from randomly ordered words. Help is provided by “Hints” 
that will give the next correct word. For a perfect score, all words must be 
used.  Experienced English language users (probably at a higher level than the 
CEFR B1/B2) can be assisted from the Subject-Verb-Object structure in 
English. As a result, a verb can never be the first word in a sentence. In the 
easier versions of the Game, the first word of the sentence might be 
capitalized, or the ending word might have sentence ending punctuation, or 
punctuation may be used as a sentence separation clue. The overriding 
strategy, however, is to try to comprehend the intended meaning, and start 
experimenting with word order before giving up and asking for help.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives

C
lu

es
O

Improved reading 
comprehension at 

the paragraph level 
demonstrated by 
answering text-

specific questions

Learners read the 
text and use the 
clues provided to 

answer the multiple 
choice questions, 

including True/False 
questions

The reading text remains on display in the left pane of the screen, so learners 
can always have access to it. This Educational Game tests deeper learner 
understanding by asking specific questions to the provided text. Although it is 
possible for less well prepared learners to do well on CluesO, well prepared 
learners will have a clear advantage over less well prepared ones. There are 
no Hints or any other Help provided, except trial and error.

Sc
ri

p
ti

n
g

Reading 
comprehension 

demonstrated by 
piecing together text 
segments to make a 

short story

Put the segments in 
the correct order to 
make a short story

Click on each segment to put it in the correct order. Not all segments are 
shown on screen at all times as in the CluesO Game. In other words, some 
segments may appear only after a displayed segment has been put in the 
correct order. This keeps the display uncluttered and makes text sequencing 
easier. Same help features as in “Word detective” above, but at the segment 
level. Learner success on the Game does not depend on text memorization, 
but on understanding the method of putting segments together to form a 
meaningful story.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives
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Sp
el

lin
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b
ee

Listen and spell Click to listen to the 
audio and spell the 

word

Spelling bee is a popular word game and competition for assessing learner 
skills for correct spelling of words. Sometimes it is used as an alternative 
method of vocabulary learning instead of flashcards (see below). Vocabulary 
skills, however, are different in that they demand learning various aspects, 
such as the meaning, synonyms, definition and/or use of particular words in 
sentences. Of all these differences between the Spelling Bee game and 
Vocabulary skills, the scope of the TREASUREHUNT project Spelling Bee Game 
focuses on spelling. 

Spelling bee competitions can raise a lot of competitiveness among learners, 
and thus the Game might be used to liven up a lackluster class performance 
or learner interest. In contrast to the US, Spelling Bee games have not taken 
up in Canada or the UK.52

Since the TREASUREHUNT project was designed as a self-study course, the 
current implementation of Spelling Bee is the best available for remote 
learning of limited social interaction learning settings.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives

W
o

rd
 s

af
ar

i Spelling skills & 
Reading 

comprehension 
improvement

Fill-in the blanks by 
typing in the missing 

words

Minimum information (no clues or definitions) and thus one of the most 
challenging games of the TREASUREHUNT project. It is probably a guessing 
game that can become frustrating, unless learners are extremely well 
prepared and have a thorough familiarity with the content. Memorizing the 
text of PR4 would be helpful if feasible, but not essential.

Help is available as “Hints” (reveal the next letter). It is recommended that 
learners having difficulties take a number of guesses before asking for a Hint. 
Learners must type in their answers, instead of selecting from a dropdown 
menu, as in Listen Up above, to assess their spelling as well as their reading 
comprehension skills. 

N
o

te
 t

ak
in

g

Spelling & listening 
comprehension skills

Fill-in the blanks by 
typing the segment 
played back by the 

audio recording

The Note Taking Game requires high quality spelling & listening skills, as there 
is no help or hint whatsoever, and seeks to improve these skills.

In the Note Taking Game as applied to the TREASUREHUNT project, the audio 
recordings have substituted for the educator reading the text.

Note Taking is a more general Educational Game than Spelling Bee and is not 
limited to the 595 agritourism vocabulary terms. This expansion to words 
beyond the agritourirm glossary was necessary to avoid overspecialization, as 
learners will need to use more words to communicate in writing with 
customers and partners alike during their regular business activities.

Like all Educational Games, Note Taking provides a sandbox for learner 
listening and spelling skills quantitative improvement to reach the set goals 
before proceeding to the Evaluation test.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives
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rm

 ID

Vocabulary skills 
improvement by 

reverse term 
identification (by its 

definition)

Drag and drop the 
definition next to the 
corresponding term

The agritourism glossary developed for the TREASUREHUNT project contains 
a wealth of information, such as English term pronunciation and definition (in 
English), translation in the other five languages of the project, spelling (in 
English and other languages), etc.

The Term ID Game aims to train learners in reverse term identification, which 
includes matching the definition with the term. This activity indicates a 
deeper understanding and better handling abilities of English language; this is 
the main reason that this type of exercise pertains to the 12th grade of 
English language school system.

Lo
rd

 o
f 

th
e 

W
o

rd
s

Boost vocabulary 
skills

Drag and drop each 
letter to the correct 
position to form a 

term

Another game of minimum support information (no Clues, only Hints) and 
thus maximum difficulty (a reason which lead to the name of “Lord of the 
Words” to show that some wizardry may be required). 

Assumes excellent vocabulary knowledge and ability to recognize the word 
even with the randomized order of letters.

The good point is that this Game includes a limited number of Quizzes and 
each Quiz includes only one answer; that is to say, there is no randomized 
order of alternative answers stored in a database for each Quiz. Once the 
learner has solved one Quiz, the answer to that Quiz will always be the same; 
thus, the learner can improve answer retention through spaced repetition.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives

M
at

ch
m

ak
er Enhance vocabulary 

& reading 
comprehension skills 

Fill-in the blanks by 
selecting the 

appropriate term 
from the dropdown 

menu

Similar action to the “Listen Up” Game, but without the audio cues from that. 
No typing is required, as this Game does not test writing (spelling) skills. Each 
term from the dropdown menu is used once, and there are no redundant 
(unused) terms; this is a design specification to make the Game easier. A 
person with near-native English language skills will probably do well on the 
Game even with limited studying of the Training Material.

C
ro

ss
w

o
rd Build vocabulary & 

reading 
comprehension

Solve the crossword 
puzzle

Crossword puzzles for the TREASUREHUNT project were generated using the 
terms of the agritourism glossary and the Hot Potatoes Jcross program.

Similar concept to the Term ID Game above, but in addition to the term 
definition, a few indirect facilitators are provided, such as number of 
characters in the term, common letters with other terms at the crossing 
points, that serve as additional information for solving the crosswords puzzle, 
and as always click on a “Hint” to get the next letter of the term.

In the above Table, “term” in singular or in plural refers exclusively to any of the 595 terms of the agritourism glossary, whereas “word” refers collectively to any 
word of the English language.

All training material, text, questions and answers, etc amended or not are sourced from the Modules and Lessons of PR4: Training Package on Agritourism. 
Therefore, to be well prepared for the Educational Games, and practice for the Evaluation, learners must study actively, repeatedly, intensively and extensively the 
Modules and Lessons of PR4.

The learning principle behind the Educational Games is “practice makes perfect”, especially when practice is combined with a little fun, such as the one provided 
by the Games. Thus, it is recommended that learners follow a spaced-repetition scheme as memory refresher for all of the above Educational Games.

It is highly unlikely that learners who have not studied the Training Material and exercised with the Educational Games will perform well on any Game by chance 
alone.
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Skill Scope Usage Game Learning objectives Learner action How it supports the learning objectives

The didactic value of the above Educational Games is verified by the fact that various global leaders of English language testing services have similar games on 
their websites. For example, the “Word detective” game (put the words in the correct order to form a sentence) is endorsed by the American English service of the 
US State Department that has posted an identical game on its website (https://americanenglish.state.gov/files/ae/out_of_order_answer_sheet.pdf)
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Daily study plan
Although learners are encouraged to develop their own study plan, the self-paced environment 
and consequently the limited role of educators may build pressure to complete the assignments 
on-time and thus affect progress negatively.

For this reason, a sample day by hour by skill study plan is provided below assuming a 5-workday 
week. Study hours are 45-minute long sessions followed by 5-10 minute breaks. Learners are 
welcome to modify the plan to suit their needs, learning habits and their other professional 
activities or commitments.

Table 3: Example of a daily study plan 54

Skill Monday Tuesday Wednesday Thursday Friday Saturday (Review 
session)

Listening

Make a 
recording of a 
chunk of 
TREASUREHU
NT text and 
listen to it.

Repeat as 
needed.

Listen to 
yesterday’s 
recording.

Listen to an 
audiobook 
for ... minutes.

Repeat as 
needed.

Make a 
recording of a 
new chunk of 
TREASUREHU
NT text and 
listen to it.

Repeat as 
needed.

Make a 
recording of a 
TREASUREHU
NT Case Study 
and listen to it.

Repeat as 
needed.

Listen to a TED 
talk on 
agritourism/sust
ainable tourism.

Repeat as 
needed.

Review (playback) all 
audio material studied.

Play the Listening Skills 
Educational Games for 
the study Lesson.

Speaking Read aloud the 
study chunk.

Select another 
chunk and read 
it.

Speak alone 
about what you 
have learned 
yesterday.

OK to peek at 
notes.

Speak with a 
friend for 10 
minutes.

Prepare a 3-5 
minute mockup 
Powerpoint 
presentation of 
the study 
chunk.

Present it “in 
class”. OK to 
peek at 
notes/slides.

Record your 
presentation.

Happy with the 
result?

Prepare a 3-5 
minute mockup 
Powerpoint 
presentation of 
the Case Study.

Present it “in 
class”. OK to 
peek at 
notes/slides.

Record your 
presentation.

Happy with the 
result?

Speak with a 
friend or 
someone you 
don’t know well 
for 30 minutes 
(e.g., someone 
from another 
country).

If none is 
available, try to 
speak with an 
AI, such as 
ChatGPT.55

Use your 
smartphone IPA 
(e.g. Siri or 
Alexa) to have 
a conversation 
on a topic you 

Review all the material 
studied.

Play the Educational 
Games for Speaking 
Skills



Skill Monday Tuesday Wednesday Thursday Friday Saturday (Review 
session)

are interested 
in.

Reading

Read silently 
the study chunk 
while playing 
the recording.

Progressively, 
eliminate the 
playback and 
read it aloud.

Read 
yesterday’s 
chunk.

Read a 
TREASUREHU
NT Case Study 
from the study 
Lesson.

Read silently 
the study chunk 
with recording 
playback.

Progressively, 
turn down the 
volume and 
read the chunk 
aloud.

Read silently 
the Case Study 
with recording 
playback.

Progressively, 
turn down the 
volume and 
read the Case 
Study aloud.

Read the TED 
Talk transcript 
(see below).

Practice 
reading.

Record the 
transcript and 
playback.

Happy with 
your reading?

Review all the material 
studied.

Play the Reading Skills 
Educational Games for 
the study Lesson.

Writing

Copy 1-2 
paragraphs to 
get used to 
English 
spelling.

Transcribe the 
recording made 
in Listening 
above. 

No peeking at 
the original text.

Write a 
summary of the 
study chunk. 

Check it with 
the 
spellchecker 
and the 
grammar tool of 
your word 
processor.

Write a 
paragraph 
about your 
favorite movie.

Read and write 
(Copy) 1-2 
paragraphs of 
the Lesson to 
get used to 
English spelling 
and to train 
your 
handwriting.

Write a 
summary of the 
Case Study. 

Check it with 
the 
spellchecker 
and the 
grammar tool of 
your word 
processor.

Write a 
paragraph in 
English about 
your favorite 
football team. 
or pet or flower 
or food.

Transcribe the 
TED talk.

No subtitle 
peeking.

Use the 
subtitling option 
after your finish 
for checking 
your transcript.

Translate the 
transcript to 
your native 
language.

Review all the material 
studied.

Play the Writing Skills 
Educational Games for 
the study Lesson.

Vocabulary

Use Anki to 
learn 10 new 
words and use 
them in 
sentences.

Run Anki to 
check how 
many of 
yesterday’s 
words you can 
remember.

Learn 10 new 
words and use 
them in 
sentences.

Run Anki to 
check how 
many of 
yesterday’s 
words you can 
remember.

Learn 10 new 
words and use 
them in 
sentences.

Run Anki to 
check how 
many of 
yesterday’s 
words you can 
remember.

Learn 10 new 
words and use 
them in 
sentences.

Run Anki to 
check how 
many of 
yesterday’s 
words you can 
remember.

Learn 10 new 
words and use 
them in 
sentences.

Run Anki to check how 
many of the 50 words 
you can remember.

Play the Vocabulary 
Skills Educational 
Games for the study 
Lesson.
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Study
Refer to the Start Learning section of PR4: A TRAINING PACKAGE ON AGRITOURISM, p. 137.

How to study 
To learn English, teach English to yourself and others (!!!)

But first, teach yourself English.

For tips on good study techniques, habits, practices, tools, effective learning, etc. visit 56

Cramming the night before the exam may help studying, but should not become a self-fulfilling 
prophecy. Studying is like packing a suitcase57: if the clothes are packed neatly, the suitcase can 
carry them nicely time after time; hasty-packing, however, will load the clothes for a while, but 
they will start falling off quite fast. It takes time to learn how to fold and put clothes nicely inside 
the suitcase. Similarly, the brain needs some to assimilate the information and to retrieve it when 
asked to do so, and gaining the experience of doing the whole thing. Consequently, learners should 
take their time to neatly arrange their study efforts and knowledge in coherent groups.

The Feynman technique
The Feynman technique58 is the concept 

“If you can’t explain something in simple words, then you don’t understand it”. 

To put it simply,

Be your own teacher

It is also known as “learning by teaching” and has been implemented as flipped-classroom. 
Essentially, it is a role-reversal technique in which Learners play the role of the teacher, after 
studying the training material and then presenting it to other learners. 

The method was invented in Germany, but its application met resistance originally, due to the strict 
disciplinarian German educational system requiring rote memorization (See spaced repetition 
below). By the 1990s, however, the German educational system realized the benefits the method 
has to offer, and mainly that it eliminates the generation gap, and thus brings teachers and 
Learners closer together. 

It has been found that “learning by teaching” is much more effective if the lecturing learner 
teaches an inanimate object, such as a rubber ducky or a plastic platypus.

The Feynman technique is summarized in four steps:

1. Research about a topic and study it
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2. Try to teach it to someone else

3. Fill in the holes in your knowledge

4. Review what you have learned and make your teaching easier to understand

As such, the Feynman technique is a modification of the Learning by Teaching technique in the 
respect that there may be no Learners to teach. Learners become familiar with the training 
material, and then flip their roles to teach themselves what they probably already know. The 
added benefit of the role flipping is that learners will solidify their knowledge and will transfer it to 
their peers in a way that they can understand. 

Due to the above benefits, it is recommended that TreasureHunt project learners use the Feynman 
technique for each one of the 4+1 linguistic skills to be mastered.

Get some more help on How to Study59

The study flow chart
The following study flow chart provides an outline of the steps in the study process.

Studying includes all training material, as mentioned in The TREASUREHUNT project training 
material, above.
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Figure 10: Generalized study flow chart for the PR4 training material and the glossary.

The left half of the flow chart is flexible, and tasks can be moved up or down without hurting study 
efficiency. For example, the task “Set your study hours” can be moved at the beginning, right after “Start” 
and all other tasks moved one step down. 

* Consistent success rate is defined as scores above the set success rate for n=4 test repetitions of each of 
the 4+1 linguistic skills. Average test scores should be avoided because they allow for some scores to be 
below the set success rate, and thus do not guarantee consistency and success. For better retention results, 
test repetitions should be spaced 3-4 days apart.



Start learning
Refer to Start Learning in PR4: TRAINING PACKAGE ON AGRITOURISM, p. 137.

Increase your productivity
You may use the screen time facility of your iPhone and check how much time you spend visiting 
various websites, etc.

Motivation fill up
Always ask yourself the question first: Why do I really want to do this?
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See Motivation section and “How to motivate a prospective agritourism entrepreneur to learn 
English”, in PR4: TRAINING PACKAGE ON AGRITOURISM, p. 132 and p. 133.

Chunking
Break content into manageable-size learning chunks to facilitate understanding and memory 
improvement. A chunk is the minimum autonomous learning unit. The size of the chunks is a 
matter of trial-and-error, but definitely not sentence-by-sentence. 

For example, the PR4: A TRAINING PACKAGE FOR AGRITOURISM has already been split to six 
Modules and three Lessons per Module. Each Lesson follows a common pattern with headrings, 
subheadings, paragraphs within headings, etc (see PR4 – Training package on agritourism, above). 
Learners are free to start their learning process at any size chunks. With time and practice, 
however, the size of the chunks will stabilize and may reach a page, with room to increase even 
more. 

Chunk your time too. It has been said that average human attention span for light audiovisual 
material (TV shows) is about 8 minutes. Therefore, any information delivered beyond the 8-minute 
threshold will result in cognitive overloading and thus forgotten.60 With time and practice, 
however, the 8-minute span can increase to 25-30 minutes.61 Split study time into 8-minute chunks 
and see how much information you can process and retain.

Learning will be more efficacious when:

1. It occurs in small chunks designed to build upon each other, and

2. Those series of chunks build upon each other by calling into use material learned in earlier 
chunks, providing both repetition and association opportunities. In other words, chunks 
must be somehow related to each other to promote learning.

The core meaning of chunking applied to learning is:

As firewood burns faster if it is split into smaller pieces, 

learning will be faster if it is broken into smaller chunks. 

And 

The smaller the pieces, the faster the burning.

However, endless splitting can be confusing; human mind tends to form associations of seemingly 
unconnected information into meaningful groups, such as individual, meaningless letters, grouped 
into larger, meaningful groups, such as words, grouped into higher pieces, such as sentences, 
paragraphs, chapters, etc.62 

Chunking might be as easy as creating a series of bullet points or steps63 and devising the 
mnemonics to store it in long-term memory, or making connections and association with other 
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memory strategies.64 Creating chunks of meaningful sets of information recalled together reduces 
the amount of information that the individual must retain.65 A typical example of chunking 
combined with mnemonics is the memorization of the Periodic Table of Elements.

For an example of how to use chunking in class, see 66

Active learning
As a last resort, if chunking doesn’t help and you have available time, employ active learning! 
Meaning, try to develop a deeper understanding of how it works, a way of connecting the pieces of 
the puzzle through meaningful or weird or funny arguments, sentences, statements, words, 
pictures, jokes, etc. Take a look at Appendix 6 – How to make the Educational Games, below.

Fight procrastination
Get rid of distractions. Clean up your desk, put your cell phone in silent mode to another room, 
close your browser so you don’t wander reading the news or your favorite webpage or social 
media; for example, install the browser extension “Social Fixer for Facebook”, close your email 
account, access to social media, etc. 

Download and install the Self Control67 free and open source app to eliminate all distracting 
website access while studying (Mac only) or FocalFilter68 for Windows.

Time management
Learners are urged to use the Pomodoro technique69, a particularly effective method for dealing 
with repetitive everyday language learning tasks. The foundation of the Pomodoro technique is the 
premise that users gain learning momentum by following a fixed time schedule of study bouts with 
short breaks between bouts.

Start with a 25/5 time frame (25-minute study, 5-minute break), move progressively to 45/15, and 
once you have built momentum to perhaps 50/10.

Breaks are even more important than the study periods! Never skip breaks, even if you have 
reached study periods near or over one hour. It is the time out the brain needs to get away from 
the problem, relax, regroup and make a strong come back!

Experiment with the study-break periods of the session to find what works best for you. 70

You might be tempted to use your smartphone stopwatch to keep the time. Don’t do it. It may 
seems easier, but learners will be too much distracted by their smartphone and they would miss 
the point. 
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Get a cheap kitchen timer and set the bell to ring at the right time.

Amazing and effective working technique!

Try not to go over the scheduled number of study hours per day. If you do, your energy levels 
might be reduced the next day.

Learning management
Use a free application, such as Excel, Google Sheets or ProjectLibre71 for project management.

The term Learning management refers to management for the entire learning project, including 
time monitoring, deliverable completion and remedial action, in contrast to the concept of Time 
management, which refers to management of hourly activities on a daily basis.

Flipped classroom
The flipped learning environment where learners become teachers of themselves. Covered mostly 
in The Feynman technique, above.

Productivity apps
Watch the video (https://www.youtube.com/watch?v=p-AMooYPO1Y)

Metacognitive skills
The study of your study patterns to learn how to learn. Refer to PR4: A TRAINING PACKAGE ON 
AGRITOURISM, p. 139

Evaluation standards
Self-assessment is a continuous process performed by learners following a completion of a 
manageable microtask, such as listening to or reading aloud one paragraph at time, etc.

Tests developed according to standardized tests of English for Specific Purposes (ESP) by:

US Department of State Bureau of Educational and Cultural Affairs
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International English Language Testing System (IELTS)
Test of English as a Foreign Language (TOEFL)

Duolingo English Test (DET)
Cambridge Assessment English

Trinity College London
British Council

Tips & tricks for test-taking

Listening
For some techniques and practice questions on how to take the IELTS Listening tests, visit 
https://www.youtube.com/watch?v=6fk6W7Knld8 

Speaking
For some tips on how to answer any IELTS speaking question, visit 
https://www.youtube.com/watch?v=z_1BQVdQLoc 

Reading
For some tips on how to answer IELTS reading questions, visit 
https://www.youtube.com/watch?v=3KDP8P-pvEw 

Writing
For some tips & rules for answering IELTS essay questions, visit 
https://www.youtube.com/watch?v=yle3Wytf_LE, https://www.youtube.com/watch?
v=yvt8RzGNhBc, etc.

Vocabulary
For some advice on how to answer IELTS vocabulary questions, visit 
https://www.youtube.com/watch?v=ZfIIfV8DMuU 

If everything else fails, try using brut force, i.e. testing different letter or word combinations to 
answer a question in the final exam. This system, however, may work for short words or sentences, 
but it will certainly fail for longer ones.
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References
American English
https://americanenglish.state.gov/ 
https://americanenglish.state.gov/four-skills-resources 
https://americanenglish.state.gov/files/ae/teachers_guide_for_creating_lessons_with_moocs-
508.pdf 

English Language and Culture Blog
The Best English Speaking Apps in 2023
https://www.fluentu.com/blog/english/english-speaking-app 

VOICE GENERATORS
How to Generate Your Own Voice - Text to Speech
https://www.youtube.com/watch?v=PzBdEW5WNGo 

BEST AI Voice Generator | Eleven Labs
https://www.youtube.com/watch?v=seMNwAav55c 

Best Voice Changer for PC | Speak using AI Voices
https://www.youtube.com/watch?v=lOmKuYMwjsk

For a more general list of links to specialized topics, consult PR4: TRAINING PACKAGE ON 
AGRITOURISM, p. 129
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PART III – APPENDICES
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Appendix 1 – Web searching

Perhaps the most important present day applications using English language is Web searching. To 
put it simply, Web searching opens up the entirety of human knowledge obtained through the 
centuries and makes it available to everyone. Regardless of whether some sources of information 
remain behind paywalls or they are open and freely available, the Web is like a multibillion volume, 
infinite space library, and growing by the second. Therefore, web searching is considered perhaps 
the No. 1 soft skill priority everybody should have and practice.

Web searching is based almost exclusively on keyword search. It is assisted by the ‘type ahead’ 
feature, which can predict the next one or more characters, and sometimes words to be entered. 
Search engines make grammar and syntax redundant: a set of keywords in the proper order will 
produce identical output with a full grammatically and syntactically correct sentence. Furthermore, 
web searching is oblivious to ‘stopwords’, that is common words that do not add significant 
information to the search string and, therefore, can be omitted.

Users can start a web search by carefully formulating the question in their native language. Verbs 
are indifferent and can be omitted. Therefore, the search should contain a selected few 
agritourism-specific keywords. Keyword order is not important, although it is advisable to keep 
keywords in a logical order. 

Before getting into details for specific web searching, two general guidelines:

A) To find equivalent applications, enter:

alternative X

where X is the software your are looking for an equivalent. 

For example, enter 

alternative Microsoft Project

B) If you ever wan to get an idea or a list of the latest and greatest software applications, enter:

Top 20 free X software

where X is the type of software you are looking for. For example,

Top 20 free accounting software

The following is a short list of Quick Tips on how to do an effective web search.72
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1. Formulate the question in your native language. In 1-2 sentences state precisely what you 
want to find from the Internet.

2. Translate the question into English; if you don’t feel comfortable with your English language 
skills, use Google translate for a rough draft.

3. Identify keywords. These are usually nouns that have special importance for your search.

4. Consult an online dictionary to find synonyms of the keywords.

5. For agritourism-related keywords, consult the glossary (treasurehuntproject.oikothesis.org) 
to translate keywords from any of the five TREASUREHUNT project languages to English and 
vice-versa.

6. Use up 6 to 8 carefully selected keywords per query. Most searches use only 1-2 keywords 
and therefore yield too many and probably irrelevant results.

7. Omit articles ("a," "the"), pronouns ("he," "it"), conjunctions ("and," "or") or prepositions 
("to," "from") in your queries. 

8. Consider skipping verbs. If, however, you want to use an AI tool, refer to The art of AI 
prompts, below.

9. If you want the EXACT keyword combination, enclose it in quotation marks; for example, 
“digital marketing campaign”, “farm stay”, “farmers market”, etc.

10. Spell carefully, and consider alternate spellings and synonyms.

11. Avoid redundant terms.

12. Customize your search using the Advanced Search option of your search engine.
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Appendix 2 – Language learning utilities

Text-to-speech converters
There is a huge variety of text to speech converters with excellent 
quality results. All of them will have audio output so users can 
hear the sound of the text. A few will allow the audio to be 
exported and downloaded as an .mp3 file.

The following is a list with some suggestions. 

Free tools
On Microsoft Word

Learners using Microsoft Word on Windows 10 can install the free 
Speak text-to-speak feature to read text aloud. For information, 
visit here73.

Browser add-ins and extensions – no .mp3 export

TTS Text to Speech – Voice Reader Online

TTSReader – Text to Speech in Page Reader

Speechify – Text to Speech Voice Reader

Select and Speak – Text to Speech

NaturalReader – AI Text to Speech

Google Translate

Converter websites – with .mp3 export

https://ttsmaker.com/ - Good voice selection; maximum 10,000 
characters – RECOMMENDED

https://ttsmp3.com/ - Selection of voice, speed, add breaks, etc.

https://www.text-to-speech.online/?
ref=taaft&utm_source=taaft&utm_medium=referral – RECOMMENDED
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Local converters – with .mp3 export

Speakline - RECOMMENDED

A small, free, user friendly program for PC and Mac.

For Windows and Mac.

Download it from https://pcmacstore.com/en/app/441968334/speakline.

Click on the cogwheel to select voice and speed. 

No word limits. Good quality audio export.

Copy & paste text, or import entire .txt or .rtf files.

Click “Play/Pause” to read or pause the text.

Export it as .aiff file.

Convert the .aiff file to .mp3 file using the free Audacity 
(https://www.audacityteam.org/) or VLC media player 
(https://www.videolan.org/) apps. 

For a list of alternatives to Speakline, visit 

https://speechify.com/product-reviews/alt/speakline/?
landing_url=https%3A%2F%2Fspeechify.com%2Fproduct-reviews%2Falt
%2Fspeakline%2F 

Browser installed voice recording add-ins & extensions

To record text to voice, use the Voice Recorder app that comes with 
Windows 10. 

Visit https://www.youtube.com/watch?v=kfqpFKdDVMU for necessary 
settings. The recording is in .m4a format; to convert it to .mp3, 
use the Audacity free app.

Customize the installed add-in and select a UK English voice, 
speaking speed and pitch, etc.; for example, in the TTS Text to 
Speech – Voice Reader Online, a good combination of parameters is 
Language/locale: All, Voice name: Karen, Average speed and pitch, 
and Hotkeys to change Speakers: Google UK English.

A list of recommended apps for speaking by specific objective

https://www.fluentu.com/blog/english/english-speaking-app/ 
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Pronunciation tools

Google pronunciation tool
The Google pronunciation tool can be applied in two ways:

A) Enter “pronounce X”, where X is the word of interest, and click 
OK. In the Pronunciation pane, select British pronunciation or 
American pronunciation, and click on the speaker icon ( ) to 
listen to the word and watch the animated ‘mouth’ image for the 
position and opening of lips and tongue while pronouncing the word.

B) In the Google search box, click on the microphone icon ( ) to 
speak the term. Watch whether Google comes up with the correct 
spelling. Read the feedback.

In your browser, enter “pronunciation X”, where X is the word you 
want to know how to pronounce. Select between British and American 
pronunciation. Click on the “mouth” icon to hear the pronunciation.

Alternatively, in the Google search box click on the microphone 
icon (Search by voice) and speak to hear its pronunciation. Select 
British or American English.

Google Chrome extension
In Google Chrome install the “Pronounce: Speech and Pronunciation 
checker” extension.74 

Sign in.

Click on “Read Aloud” and start reading a text segment. 
Unfortunately, there is no functionality of entering your own text.

Record the text by speaking to the internal microphone, and 

Receive instant feedback by word, with suggestions on how to 
pronounce correctly any mispronounced word, as well as the words 
pronounced like a native!. 

Additional feedback on Clarity and Engagement 

Repeat until you get the pronunciation right.

7-day free trial, then €7.52 per month.
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Appendix 3 – AI enhancements

Can AI be used in English as a second language 
learning?

Recent study by the British Council 
(ai_in_english_language_teaching_systematic_review.pdf 
(britishcouncil.org)

Exploring AI For Language Learning: Benefits, Challenges, And 
Future Trends (Exploring AI for Language Learning: Benefits, 
Challenges, and Future Trends - Dr. Language (drlanguage.org)), and

Artificial intelligence technologies and applications for language 
learning and teaching (Artificial intelligence technologies and 
applications for language learning and teaching (degruyter.com))

Consensus: In summary, AI enhances English Language Training & 
Learning (ELT/L) by adapting to individual needs, providing real-
time feedback, and creating engaging learning experiences. 

What Is ChatGPT & How Can It Be Used for Language 
Learning?

Visit https://www.youtube.com/watch?v=vHKCsrYkpNk, etc.75 76

Each of the four major AI platforms (ChatGPT, Bard, Bing, Claude) 
offer speaking chat capabilities.

Use your smartphone to start and continue a conversation away from 
your desktop computer. The mobile app is called Bing on the App 
Store; other AI platforms include chatGPT, Bard and Claude.
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Nobody around to have a chit-chat with? Try a chatbot
The AI capabilities have completely transformed the traditional 
language learning.77

When there is nobody available to talk to, or for extremely 
introvert learners, a conversation with a chatbot may provide the 
best solution. Chatbots are not judgmental, and learners can 
request that the chatbot corrects their speaking mistakes. 

For a list of AI chatbots, visit 78.

The best way to start a conversation with ChatGPT is to assign the 
role of a penpal to it79:

“Hello! Please be my penpal. Let’s talk about…”

or assign ChatGPT a role and ask it to play along:

“You are a digital marketing expert and I want to launch my 
agritourism startup to make money. What do you recommend?”

or

“Please be my private English language tutor and let’s start a 
conversation on ...”

With the free Bing copilot installed on Microsoft’s Edge browser, 
learners can have a conversation with a chatbot about any topic. 
Limit of 30 answers per session and 300 responses per day. Limits 
are reset daily.

Download and install on your smartphone or your desktop one of the 
four major AI platforms: OpenAI’s ChatGPT, Google Bard, Microsoft 
Bing, Claude.

ChatGPT is perhaps the most appropriate AI for conversation with 
language learners.80 Its major drawback is that it doesn’t have 
built-in voice capabilities. It is very easy, however, to install 
voice control on ChatGPT.

Add voice control to ChatGPT
For a two-way voice conversation with a chatbot, voice control is 
required.81

In Chrome Web Store, add the extension “Voice Control for ChatGPT” 
to Google Chrome. Select the speed and UK or USA English.

To enter voice prompts, press the space bar anywhere on the screen.
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Using smartphones, learners can speak to ChatGPT, but the AI tool 
does not have native speaking capabilities, and therefore will 
provide written answers. To enable ChatGPT voice capabilities, 
install the Chrome extension ChatGPTVoice or ChatGPT MOD. 

Start a conversation
Learners could type the following prompts to start a conversation; 
in addition, they request that ChatGPT corrects each learner 
sentence before continuing the conversation:

“You are an expert English teacher, and I am an intermediate 
English learner. Let’s have a conversation in English where 
you correct my responses for any errors before continuing 
the conversation. You start.”

ChatGPT can act weird. Sometimes it just corrects your sentence, 
but does’t continue the conversation. Other times, it forgets to 
correct your sentence. To correct this inconsistency, give ChatGPT 
some structure and make it respond in a useful way. The following 
provides an example of how to start a conversation by describing 
what ChatGPT should do:

“Play the role of my engaging, good-natured, 
motivational English teacher. Correct my English if I 
make a grammatical or other linguistic error and 
explain what the error was. After I send a message, and 
before correcting it, tell me what I said wrong and 
correct my English. Then in the next paragraph, jump 
straight into the conversation. Keep your answers to no 
more than 50 words. You start.”

Or you can get more practical and have a conversation on Short 
situational dialogs on everyday topics. Visit 82 to get some more 
ideas.

Like a car in autopilot, ChatGPT can still make mistakes, so user 
attention at all times is advised. If ChatGPT continues to make 
mistakes despite a more strict description of the situation and 
requests, change the wording of the prompt into a more detailed 
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one. In case of still not getting the expected results and before 
trying ChatGPT4, experiment with giving more or less details and 
which prompt format gives the right answer.

Keep practicing even after you have attained a good level.

Get help by listening to the pronunciation of the terms in the 
TreasureHunt Project glossary web or mobile apps.

B) Browser installed speech-to-text apps

----------------------------------------

Search the App Store, Google Play, and Microsoft Edge for Speech to 
Text apps, add-ons or extensions. 

Many of these extensions are common or have equivalents for the 
three browsers.

Download and install the piece of software of your choice. Download 
the extension based on the number of downloads, positive reviews or 
rankings.

Alternatively, you can use the voice input software of your 
computer, such as Siri for MacOS, or note-taking app

Small talk

----------

Consult and practice the “Dialogs for everyday use” 

https://americanenglish.state.gov/resources/dialogs-everyday-use

Keep a conversation going
CAUTION: AI tools are usually very fast in answering prompts. 
Therefore, learners should be somehow prepared to hold a 
conversation; in other words, learners should have brainstormed 
with themselves and prepared a list of about 4-5 followup questions 
to AI tool answers. It is not important if these questions are not 
directly connected to the tool’s responses. The main point is for 
the learner to start and keep up a conversation to improve his/her 
listening or reading comprehension skills. 

- 84 -

https://americanenglish.state.gov/resources/dialogs-everyday-use


Another interesting point learners may wish to experiment with is 
whether the AI tool will respond consistently to the same questions 
after a few days or whether different AI tools will yield similar 
responses.

Below are some examples of conversation subjects and things to talk 
about. These examples are indicative and learners are encouraged to 
supply their own input.

Add voice control to ChatGPT as explained above, and keep going.

On agritourism businesses
 What are the most effective strategies for starting a successful 

agritourism business?

 How can I secure funding for my agritourism business idea?

 What are the key factors to consider when choosing an agritourism 
farm location?

 How can I identify and target my ideal customer base for my 
agritourism business?

 What steps can I take to manage the finances of my agritourism 
business and stay profitable?

 How can I effectively market my agritourism business to attract new 
customers?

 Where should I market my agritourism business to grow my business?

 What are the best practices for managing and leading a team?

 How can I measure the success of my agritourism business and make 
necessary adjustments?

 What resources are available to support the growth and expansion of 
my agritourism business?

 How can I stay ahead of the agritourism industry trends and adapt 
to changes in the market?

On agritourism entrepreneurs
 As an entrepreneurial expert, what methods would you recommend I 

use to test the viability of my agritourism business startup?

 Can you suggest the top methods for securing funding for a new 
agritourism venture?
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 What marketing strategies would you recommend for someone looking 
to promote a new agritourism business?

 What advanced technologies, like industrial Chemistry, could an 
agritourism entrepreneur apply to increase business profit?

 What strategies would you recommend for someone looking to use 
crowdfunding to raise funds for their business?

 In which countries is the idea of agritourism appreciated most?

 Which people are more willing to spend money to visit agritourism 
installations in other countries?

 What steps would you recommend for someone looking to build a 
strong and effective team for their agritourism business?

 What cash flow management techniques would you recommend for 
someone starting a new agritourism business?

 As an entrepreneurship expert, what strategies would you recommend 
for someone looking to secure funding for a new agritourism 
business?

 What are the prospects of agritourism at a global scale?

 What are the prospects of starting a new agritourism business by EU 
country?

 What strategies would you recommend for entrepreneurs looking to 
scale their agritourism business and grow it to the next level?

 Can you suggest the top methods for networking and building 
relationships as an agritourism entrepreneur?

 What strategies would you recommend for a prospective agritourism 
entrepreneur looking to make a successful pitch to investors?

 What strategies would you recommend for someone dealing with 
competition in a new agritourism business?

 Should a prospective agritourism entrepreneur go cheap and low or 
wide and high?

 What risk management techniques would you recommend for 
entrepreneurs starting their new agritourism business?

 What steps would you recommend for entrepreneurs looking to pivot 
their agritourism businesses and adjust their strategy?
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On environmental issues
 As an expert in environmentalism, what strategies have the greatest 

potential to reduce carbon emissions?

 As an expert in environmentalism, what are the top environmental 
challenges facing the world today?

 As an expert in environmentalism, what actions can individuals take 
to make an impact on climate change?

 As an expert in environmentalism, what renewable energy sources 
have the greatest potential for growth and adoption?

 As an expert in environmentalism, what measures can be taken to 
protect biodiversity and endangered species?

 As an expert in environmentalism, what are the impacts of 
deforestation on the environment and society?

 As an environmental expert, what are the most effective ways to 
reduce the use of single-use plastics and their impact on the 
environment?

 As an expert in environmentalism, what policies need to be put in 
place to address environmental issues?

 As an expert in environmentalism, what technologies have the 
potential to greatly reduce carbon emissions?

 As an expert in environmentalism, what steps can communities take 
to work together and address environmental issues?

On financial advice to agritourism businesses
 Please suggest effective savings & investment strategies for 

building wealth through an agritourism business.

 As an expert, please provide tips on creating a budget that works 
for an agritourism business.

 What are the top investment options for long-term growth of an 
agritourism business?

 Please suggest strategies for paying off debt of an agritourism 
business in a timely manner.

 Please provide tips on planning for a secure financial retirement 
of an agritourism entrepreneur.

 As a financial expert, what strategies would you suggest for an 
agritourism entrepreneur to maximize their retirement savings?
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 As a financial expert, what real estate investment options would 
you suggest for agritourism entrepreneurs looking to diversify 
their portfolio?

 What strategies would you recommend for someone looking to 
establish a rainy day fund for unexpected expenses?

On Customer Relations Management
 Please provide tips on how to improve communication in customer 

relations of an agritourism business.

 What are the best strategies for effectively handling conflict in 
customer relations of an agritourism business? How about discounts, 
gifts, freebies, champagne in their rooms, free-rides, rain checks, 
etc.

 What are the best ways to build trust in customer relations?

 What are the best strategies for having customers of an agritourism 
business return for more sales?

 As an expert, please provide tips on how to manage jealousy in 
customer relations.

 What are the best ways to keep live, long-term and prosperous 
customer relations?

 What are the best ways to make deeper customer relations and build 
customer loyalty?

 What are the best strategies for dealing with customers who are 
confrontational?

 What are the best strategies to restore trust in a small 
agritourism business?

 What are the best ways to restore contact with long-forgotten 
customers so they will return to and bring new income to the 
agritourism business?

Politics, religion, alternative health, sex and personal gender 
preferences are off limits.
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AI tools for language learning
So many tools, so little time to play.

Within the first six months of 2023, AI tools, such as ChatGPT83, 
Bing84, Bard85, Claude, etc have revolutionized the traditional 
language learning. 

For an overview of the thousands of AI Tools sorted by product 
category, visit 86 and/or 87 and The #1 AI aggregator There Is an AI 
for That88.

See also https://teflbarcelona.net/10-powerful-ai-tools-for-
language-teachers/ 

Caution: some of these tools might not work or perform as promised. 
Consult the reviews section of each. Furthermore, these tools have 
a fixed number or lessons or words that may be not be relevant to 
the English-learning requirements of the TreasureHunt project.

Almost all of the following tools are not free; they provide 
limited time or character trial versions, but their full potential 
is behind paywalls. Despite their impressive front ends and 
functionalities, many of them require computer skills beyond the 
grasp of the average end user. Another issue is that the majority 
of the websites require users to sign up for an account even for 
the demo versions.

Learners are free to browse through any of the tools listed below. 
To avoid waste of time, however, learners must have clearly 
established goals and resources before starting their browsing.

Text to speech
One of the most active areas in the AI revolution, striving to 
provide more natural-sounding human voices, intonation, etc.

There are several TTS synthesis tools available, such as Google 
Text-to-Speech, Resemble AI, Murf AI and Synthesys, which offer a 
wide range of voices and languages to choose from. For a list of 
text to speech AI tools with human-like voices, visit 89 and 90. 
These lists are by no means exhaustive, but provide a starting 
point in the quest for text-to-speech AI tools. All of these tools 
are freemium (free-to-try, pay-to-use) or they have some kind of 
limit on the number of words or characters the free version can 
handle or the time the tool will remain free. They support text-to-
speech, voice generation and cloning, and offer hundreds of voices, 
styles (emotions), etc.
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TTSMaker91 is a free exception to the above. In addition, they are 
not standalone, meaning they do not run autonomously on a local 
computer, but they include uploading text file(s) to the respective 
website. 

Murf AI, DALL-E, etc offer integration interfaces to Canva92.

Speech to text
Google Cloud Speech-to-Text, Microsoft Azure Speech to Text, and IBM Watson Speech to Text, 
which offer high accuracy and support multiple languages.

BUZZ offline audio transcription (speech to text conversion)93 based on Open AI’s Whisper.94 Also, 
transcribes audio/video files with TIME STAMPS!!! Yields .srt, .txt files, etc. for subtitling. 

Google docs add-in for dictation and speech to text conversion.

ConvertSpeech website. Online free speech-to-text for US English language.95

Chatbots for conversation practice
ChatGPT, Duolingo, and Replika are examples of popular language practice chatbots that utilize AI.

Video captioning and subtitling tools
YouTube’s automatic captioning feature and Amara are examples of popular video captioning and 
subtitling tools that utilize AI.

Pronunciation assessment and feedback
ELSA Speak96, Pronunciation Power, and SpeechAce97 are examples of popular speech evaluation 
and feedback tools that utilize AI to help learners improve their pronunciation, fluency and overall 
quality of spoken English.

Grammar and vocabulary checkers
Grammarly, ProWritingAid, and Ginger are examples of popular grammar and vocabulary checker 
tools that utilize AI.

Language translation tools
Google Translate, DeepL, and Microsoft Translator, which support multiple languages and provide 
quick and relatively accurate translations

Adaptive learning platforms
Babbel, Rosetta Stone, and Duolingo are examples of popular adaptive learning platforms that 
utilize AI.
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VR for immersive language learning
MondlyVR (chatbot and speech recognition), VRChat, and ImmerseMe, use AI-powered 
simulations to create virtual environments where learners can practice their language skills in 
realistic contexts.

Content creation tools for audio and video
Synthesia, Lumen5, and Content Samurai use AI technologies to generate original videos by 
automatically converting text into video content, complete with visuals, animations, and voice-
over. Similarly, tools like Podcastle, Descript, and Audioburst use AI to generate original audio 
content by converting text into natural-sounding voice recordings.

The art of AI prompts
In general, AI prompts are verb requests to the computer to perform an action.

To tame the power of Large Language Models (LLM)98, such as ChatGPT, Bing, Bard, Claude, etc. 
users must run a web search on “X list of prompts”, where X is the LLM they intend to use. For 
example, the search “GhatGPT list of prompts” yielded a collection of over 3000 prompts, 
examples, use cases, APIs, etc.99

Language learning
https://www.weaiprompt.com/chatgpt-prompts-for-language-learning/ 

Practice
https://polyglotclub.com/wiki/Language/Multiple-languages/Culture/Useful-ChatGPT-Prompts-for-
Language-Learning#Prompts_for_Practice_Conversations 

Role playing
https://polyglotclub.com/wiki/Language/Multiple-languages/Culture/Useful-ChatGPT-Prompts-for-
Language-Learning#Prompts_for_a_Role-play 

Reading improvement
https://www.cambridge.org/elt/blog/2024/01/31/6-tips-for-using-generative-ai-tools-in-the-elt-
classroom/ and
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https://www.aigraderapp.com/ai-apps-for-teachers/top-ai-tools-for-reading-and-listening-
comprehension-exercises/ 

Writing correctly
https://polyglotclub.com/wiki/Language/Multiple-languages/Culture/Useful-ChatGPT-Prompts-for-
Language-Learning#Prompts_for_Checking_Writing_Correctness 

Vocabulary building
https://polyglotclub.com/wiki/Language/Multiple-languages/Culture/Useful-ChatGPT-Prompts-for-
Language-Learning#Prompts_for_Vocabulary_Building 

Cultural understanding
https://polyglotclub.com/wiki/Language/Multiple-languages/Culture/Useful-ChatGPT-Prompts-for-
Language-Learning#Prompts_for_Cultural_Understanding 

Listening
https://www.britishcouncil.org/exam/aptis/research/projects/assessment-literacy/listening

Speaking
https://www.britishcouncil.org/exam/aptis/research/projects/assessment-literacy/speaking 

Reading
https://www.britishcouncil.org/exam/aptis/research/projects/assessment-literacy/reading 

Writing
https://www.britishcouncil.org/exam/aptis/research/projects/assessment-literacy/writing 
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Vocabulary
https://www.wordtune.com/blog/how-to-write-well-by-improving-your-vocabulary 

- 93 -

https://www.wordtune.com/blog/how-to-write-well-by-improving-your-vocabulary


Appendix 4 – Good writing practices
If you ever find yourself not knowing how to start or what to write in a concise but informative 
way, remember the

5W + 1H

rule, where the Ws and H are initials of the words:

Who

What

Where

When

Why, and

How

These are the ultimate information fields necessary to convey a clear idea in a short way. The 
content for each of the above six fields can be as short as one word or up to one sentence.

A cookbook for good writing
Below are some guiding principles:

 Don't hype. Avoid words like novel, highly, clearly, greatly. Better still, avoid all 

adverbs. 

 Don't use clichés. In a nutshell, by and large, they are clear as mud. 

 Don't use "very" too often. Usually, it can be replaced with better one. 

 Be concise. Avoid phrases like “by means of”, “despite the fact that”, “in order to”; 

replace them with the much shorter “by”, “despite” and “to”.

 Avoid negatives. For example, use "unable" instead of "not able". 

 Avoid redundancy. For example, use "investigate" instead of "conduct an 

investigation of". 

 Use active voice. Although not always possible, most of the text should be in active 

voice. 

 Avoid inappropriate language. Keep words like "really”, “actually”, “pretty much" for 

social networks. 
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 Avoid rare words and latinisms. Non credo all readers know the meaning. 

 Keep abbreviations to a minimum. Abbreviations are hard to read, consider just 

spelling it out. 

 Beware of zombie nouns. Utilization of nominalization is causation of distraction. 

 Do not use “tortured phrases”; they are signs of generative AI text and paper mills.

Guidelines for writing in plain language
https://www.plainlanguage.gov/guidelines/ 

https://www.gov.uk/guidance/style-guide/a-to-z-of-gov-uk-style 

Consult: Writing Skills Practice Book for EFL

https://usafiles.net/HB3/
How_to_Write_Effective_Business_English_Your_Guide_to_Excellent_Pro
fessional_Communication_4th_Edition.pdf 

BBC How to Worksheets
https://www.bbc.co.uk/learningenglish/english/downloads 

How to write e-mails in English
18 office ready email writing tips
https://www.wallstreetenglish.com/blog/how-to-write-formal-emails-
in-english 
https://www.youtube.com/watch?v=xay5TeJVSC0 
https://www.youtube.com/watch?v=3Tu1jN65slw 
https://www.youtube.com/watch?v=moIucWGgvMc 

How to write a good email
https://learningenglish.voanews.com/a/how-to-write-a-good-email/
5649722.html 
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Appendix 5 – Gamification

The value of gamification in learning languages has been established worldwide. Games, however, 
are a double-edged sword for language learning. Action-packed, captivating and addictive games, 
full of special effects and graphics can detract user attention to action; thus, these games are a 
waste of time that could be invested in learning. Games with no action, on the other hand, can 
become boring, and thus learners abandon them soon with limited learning success.

Simulation games, such as Second Life, Minesweeper, SimFarm, etc. and can be also helpful to 
learning English and for developing other soft skills, such as communication, managerial, financial, 
marketing, etc. and thus are highly recommended as past-time activities.

Added games, videos, podcasts, crossword puzzles, find-the-word, hangman, etc. can also provide 
engaging content, and therefore can be used for linguistic or other soft-skill development. 
However, caution is recommended because game action may consume precious study time, 
although recently, it has been supported that action video games can be used for language 
learning.100, 101

Other popular commercial games, not necessarily online, are Taboo, Scrabble, Trivial Pursuit, etc. 
Interested learners can use their creativity to devise their own educational games, whether 
language- or soft-skill oriented, based on the games mentioned above. For example, learners can 
devise their own deck of cards with agritourism terms from the project Glossary to play Taboo.

In addition to the classical word games, like charades, hangman, anagrams, crossword puzzles, 
find-the-word, Scrabble and tongue-twisters, there are several public webpages with word games, 
quizzes, etc. such as Quizlet102, Games for Pages103, Merriam Webster’s Dictionary Games & 
Quizzes104, the Facebook Word Games page105, and other webpages with lists of English language 
learning games106. 

The global rise of word games
Worldwide, people seem to love word games. The COVID-19 epidemic, the lockdowns and remote 
working enhanced this picture. The New York Times Games webpage has become viral and a 
source of substantial income, averaging over 10 million daily players across all platforms and 1 
million premium subscribers.107 Other major US daily newspapers, such as The Washington Post108 
and Los Angeles Times109 have special Word Games webpages with about 40 games each ranging 
from Crossword to Scramble to Anagrams to Wordsearch to Spelling Bee110, etc. on a subscription 
basis. European English speaking journals, such as The Guardian, follow suit and publish regularly 
word games,111 articles and reviews about word games112. A couple of years ago, The Guardian 
published a review article with a list of the best word games to try after Wordle113, a very popular 
word game.
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A search on Google Play revealed over 30 free to download word games extensions that can be 
installed on Google Chrome, whereas a “word games” search on Amazon revealed 703 items!

Word games as a language-learning tool
Just because word games are popular for entertainment, does not make them automatically 
suitable for language learning. 

A Google Scholar search for the keywords “games for effective language learning” yielded a list of 
over 200 technical publications published in the last 25 years. The consensus among these papers 
was that interactive games can be used for effective language learning as they improve learner 
engagement, motivation and learning outcomes in classroom.

It is estimated that there are up to 100 online games (free or behind paywalls) that can be used for 
language learning.

To assess the opinion of the language-educator community, however, we asked a number of 
questions: Do word games have any educational/didactic/learning/pedagogical value? Can word 
games be used for effective language learning? What is the position of the major 
English-learning/teaching/testing institutions, such as the British Council, Cambridge English 
Language Assessment, IELTS, Educational Testing Service’s Test of English as a Foreign Language 
(TOEFL), American and British Universities, and American English at the US Dept. of State, 
regarding the use of games for English language learning purposes? 

All of the above English-language learning/testing institutions have games on their websites. Some 
of them mention particularly the benefits of spaced-repetition flashcard Anki software and 
recommend that learning games are tested first by the teacher and knowledge passed on to the 
learners.114 Odo (2016) made the interesting point that teachers’ experience in learning English 
gives them valuable insights that can be used to evaluate the effectiveness of online suggested 
learning games.115 Others point out that word games make learners feel comfortable with one 
another, massage learner brains and thus open them up to receive new knowledge, and remove 
the feeling of anxiety and threat.116

Other commercial, online language-learning platforms, such as DuoLingo, thrive (3M Ratings in the 
Mac App Store with an average of 4.7 out of 5 stars) by offering some kind of educational games. 
Below is the Editors’ Choice Note for the app: 

With its friendly approach and awesome updates, Duolingo’s long 
been one of our favorite apps for learning another language. Its 
secret: making the process genuinely fun. Engaging mini-games test 
your reading, writing and speaking skills and joining a club (where you 
can encourage and compete with others) adds a great social element. 
Bonus: all those languages and games are available for free!
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Appendix 6 – How to make the Educational Games

Introduction
Appendix 6 is addressed to both learning coaches and learners that want to get a look under the 
hood of the Educational Games. The two groups must have a good knowledge of English, computer 
knowledge beyond the end-user level, and must be willing to experiment while studying. 

The groups will build their own Educational Games/Exercises, based on PR4 and enhanced by the 
latest AI technology. Hence, the groups will learn by shadowing Part II and thus gain experience in 
making exercises for each linguistic skill and perhaps develop some ideas on how to enrich course 
teaching/learning. 

Learners develop their own exercises by using the Hot Potatoes suite of programs and shadowing 
the Educational Games in Part II. Required for active learner involvement in the learning process, 
understanding the mechanics of exercises, and mastering various tools useful in many learning 
situations. Refer to the Evaluation standards section above about how global leaders in English 
testing structure their tests.

Moreover, Appendix 6 contains innovative, quantitative and objective methods of self-assessment, 
references to educational material beyond the TREASUREHUNT project for practice, tools for 
overcoming the weaknesses of the training material (see Strengths and weaknesses of training 
material, above), etc. 

Appendix 6 can be used as a textbook or reference point for English-language studying and 
continuous self-improvement after the TREASUREHUNT project ending date. Therefore, Appendix 6 
is not for the faint-hearted and needs special handling. In addition, Appendix 6 contains 
information beyond the TREASUREHUNT project, such as references to audiobooks and podcasts, 
Thinking-Out-of-the-Box, Fun & Games, and AI-enhancements sections. 

With the wealth of training material offered, Appendix 6 could be blamed for not leaving enough 
freedom for learners to take initiatives and learning into their own hands. It should be clarified, 
however, that the material presented in Appendix 6 is suggested material and could act as 
template for learners to create their own learning plan or modify these suggestions as required. 

This expanded learning material in Appendix 6 came as a response to anonymous criticisms about 
who will be monitoring learner progress and how. Critics seem to forget that the TREASUREHUNT 
project has a strong self-study component, and thus the responsibility of continuous progress 
monitoring lies with the learners. Appendix 6 provides many check points for self-monitoring while 
it could be upgraded later for direct learner progress monitoring.
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Listening skills

Learners prepare their individual Learning Plan for Listening skills, based on the Proposed learning 
plan template, above.

Output: 3 games for Listening Skills improvement (Connections, Listen and fit and Listen Up)
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Table 4: Listening skills educational game development plan

Game

Connections Listen and fit Listen Up

Objective

improved learner listening 
comprehension at the term level.

improved learner listening 
comprehension skills at the sentence 
level.

develop a test for improving learner 
listening comprehension skills at the 
paragraph level.

Type of questions Match type Match type Fill-in the blanks

Hot Potatoes application JMatch117 JMatch (see 117, 118) JCloze118

Sample tests

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/listening/5.6.1.L.A-MATCH.htm

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/listening/5.6.1.L.B-MATCH.htm

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/listening/5.6.1.L.C-FIB.htm

Learner action

Listen to the audio and drag-and-drop 
it next to its written form. 

Listen to the audio and drag-and-drop 
it to the sentence from where it is 
missing.

Listen to the audio of each sentence 
and fill-in-the blanks from the drop-
down menu of terms next to the 
missing term.

Development guidelines For each Lesson in a Module, 

1. Select at random 10 vocabulary 

For each Lesson in a Module,

1. Select 10 sentences including 

For each Lesson in a Module,

1. Select a 50-100 word text 

- 100 -

https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.C-FIB.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.C-FIB.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.C-FIB.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.B-MATCH.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.B-MATCH.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.B-MATCH.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.A-MATCH.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.A-MATCH.htm
https://treasurehunt-games.oikothesis.org/PR5-HotPot/EL2/listening/5.6.1.L.A-MATCH.htm


Game

Connections Listen and fit Listen Up

terms from the Lesson.

2. Convert each term to audio using 
the text-to-speech tools in 
Appendix 2 – Language learning 
utilities.119

3. Insert each written term in a cell 
of the left column of the JMatch 
tool.

4. In each cell of the right column, 
enter a link120 to an audio file 
corresponding to the term on the 
left cell..

5. Save the JMatch file and output 
to .htm file.

6. Repeat the above for the other 
two Lessons in the Module, and 
each of the six Modules of PR4.

Case Studies. Each sentence 
should contain one and only one 
of the glossary terms (the target 
term) for the specific lesson.

2. Record each sentence using the 
tools in Appendix 2 – Language 
learning utilities and embed the 
audio file in the left column of the 
JMatch program. 

3. Insert the sentences in the left 
column of the JMatch. 

4. Replace the term in question with 
blanks.

5. In the right column, create a link 
to the appropriate term.119

6. Save the JMatch file and output 
to .htm file.

7. Repeat the above for the other 
two Lessons in the Module, and 

segment. Each select sentence 
must contain one glossary term. 
If a sentence does not contain a 
term, skip it.

2. Enter the text to the JCloze tool.

3. Select 10-15 terms from the text 
and blank them.121

4. Use one of the text-to-speech 
conversion tools in Appendix 2 – 
Language learning utilities to 
make a recording of the full text 
segment (no blanks). 

5. Make a recording at normal 
speed, a second one with 5-sec 
breaks between sentences, and a 
third recording with 3-sec breaks 
between sentences. Make sure 
you include full-word references 
to punctuation symbols.
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Game

Connections Listen and fit Listen Up

each of the six Modules in PR4. 6. Download and save the 
three .mp3 files.

7. In the JCloze > Titles/Instructions 
tab, “Exercise subtitle:” and the 
“Instructions:” panes, provide 
instructions and the links to each 
.mp3 file.122 

8. Use the Listen Up Sample tests, 
above, as a template for the 
instructions text.

9. Save the JCloze file and export it 
as .htm file 

10. Repeat the above for the other 
two Lessons in the Module, and 
each of the six Modules in PR4.
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Pronunciation assistance
https://www.merriam-webster.com/, enter the word and click on the speaker icon

In your browser, enter “English to X google translate”, where X is the learner native language; in 
the left pane of the opening window, type the English word and click on the speaker icon

https://www.wordreference.com/; interesting selection of English dialects. Enter the word in the 
browser box, click on Search (magnifying lens), and click on the speaker icon 

Desktop environments
1. In Google Chrome, install the free Speechify extension, or the series of alternative 

extensions listed in Text-to-speech converters in Appendix 2 – Language learning 
utilities.

2. Speechify highlights each word of the text while reading it; thus it is easier for learners 
to monitor the reading flow and make the association between listening and reading.

3. Login to the TREASUREHUNT project website123.

4. Select a lesson to study. Break it to smaller manageable segments, such as paragraphs.

5. Move your cursor to the left of a paragraph; the blue circle with a white triangle icon (

) moves with your cursor.

6. Select a chunk of text you would like to have Speechify read to you.

7. Click on the triangle icon for the app to start reading.

8. Adjust the voice, pronunciation and speed by clicking on the emerging pane at the 
bottom right corner of the screen.

9. Replay the segment as many times as necessary to train learners ears to the sound of 
the segment. 

10. Learners will judge themselves how many times to repeat the listening process. Keep in 
mind that practice makes perfect.124

11. Focus on listening to pronunciation and intonation details; read aloud for speaking skills 
will come later.

12. Once they have finished their listening practice on the paragraph, learners move on to 
the next one and repeat the above series of steps.

https://www.wordreference.com/
https://www.merriam-webster.com/


In other browsers, such as Firefox, “speechify” may not be available; however, the “Read Aloud: A 
Text to Speech Voice Reader” or “Text to Speech” add-ons yield equally good results.

Microsoft Edge comes with a built-in Immersive Reader read aloud functionality (icon to the left of 
the “Add this page to favorites (Ctrl+D) star); click on the Immersive Reader icon and a new pane 
will emerge; click on the “Read aloud” button to start reading. 

Settings are available by clicking the hamburger icon at the top row of and include country/reading 
selection, voices, etc.

To practice their listening skills, learners can have Microsoft Edge read aloud a particular section as 
follows:

1. Make sure you have Microsoft Edge installed.

2. Highlight a text segment.

3. Click on the Immersive Reader icon (open book icon with a speaker symbol) on the 
search bar.

4. Click on “Reading Preferences” and select settings.

5. Click on the “Read Aloud” link.

6. Click on the “Pause” symbol (two parallel bars) at the middle top line of the window to 
interrupt reading.

7. Click the “Voice Options” link to the right of the browser window, to make more 
settings.

8. Click on the “Continue to Read Aloud” button to resume reading.

9. Repeat steps 2-8 as many times as necessary.

10. Be your own judge regarding when to stop. 

The benefit of browser extensions and add-ons is that they run locally and do not require export of 
the training material to servers outside the TREASUREHUNT project website.

Smartphones
iPhone built-in voice capabilities

Settings > Accessibility > Spoken Content > Speak Selection > Highlight Content On

OR 

Settings > Accessibility > Spoken Content > Speak Selection On (to speak selected text) > 
Speak Screen On > Highlight Content On
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For UK English voices, 

Settings > Accessibility > Spoken Content > Speak Selection > Speak Screen On > 
Pronunciations > + > Languages – English UK > 

Voice selection
Settings > Accessibility > Spoken Content > Speak Selection > Speak Screen On > 
Pronunciations > + > Voices > All > Set your preference.

Self-assessment
Once learners have studied sufficiently for the Lesson, as 
described above, it is recommended that they take the respective 
self-assessment and compare their performance with the set goals. 
The existing Educational Games (https://treasurehunt-
games.oikothesis.org/) provide the self-assessment tool and sample 
tests.

If Self-assessment scores are in the “Far:” range of the respective 
End point, learners must review the training material to identify 
weaknesses and take remedial action. 

An additional step in this direction is to prepare Listening skills 
Educational Games as described in Table 4: Listening skills 
educational game development plan, above. This step enhances active 
learning and provides additional leverage for improved performance.

The review process and remedial action cycle must continue until 
Self-assessment scores are within the “Near:” range of the End 
point scores.

At that point, learners are considered ready to proceed to the 
Evaluation.

Evaluation
Login to the TREASUREHUNT e-learning platform 
(https://edu.treasurehuntproject.eu/modules). 

If you don’t have an account, sign up for free.

Take the tests in the respective Module and Lesson.

The tests are closed-type questions and they are very similar to 
the Educational Games.

You can interrupt the test-taking and continue later.
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Upon successful completion, you will receive a personalized 
certificate of completion for the Module.

Speaking skills

Output: 3 Educational Games for Speaking Skills improvement (Sounds similar? Rhyming words, 
Spot the not)
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Table 5: Speaking skills educational game development plan

Game

Sounds similar? Rhyming words Spot the not

Objective

improve speaking skills by active 
learner term pronunciation recall and 
comparison with pronunciation of 
other words to find sound similarities

improve speaking skills by active 
learner term pronunciation recall and 
comparison with pronunciation of 
other words to find sound similarities

improve speaking skills by active 
learner term pronunciation recall and 
contrast with pronunciation of other 
words to find dissimilarity

Type of questions Multiple-choice Multiple-choice Multiple-choice

Hot Potatoes application JQuiz125 JQuiz JQuiz

Sample tests
https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/speaking/5.6.1.S.A-MC.jmt.htm 

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/speaking/5.6.1.S.B-MC.jmt.htm 

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/speaking/5.6.1.S.C-MC.jmt.htm 

Learner action

Find the word that sounds exactly the 
same (homophone)126 OR has similar 
sounding ending (rhyming) with the 
given term. Learners will have to 
actively pronounce the given term and 
each of the choices and decide which 
has an identical sound or the ending 
sound is closest to the term.

Find the word that has similar 
sounding ending (rhyming) with the 
given term. Learners will have to 
actively pronounce the given term and 
each of the choices and decide which 
ending sound is closest to the term.

Identify the word with different 
sounding ending with the given term. 
Learners will have to actively 
pronounce the given term and each of 
the choices and decide which ending 
sound is DIFFERENT from the term.
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Game

Sounds similar? Rhyming words Spot the not

Development guidelines For each Lesson,

1. Select 5-10 glossary terms from 
the Lesson

2. Find 3-4 homophones or rhyming 
words127 for each term

3. Use the JQuiz application of Hot 
Potatoes to make a multiple-
choice test

4. Enter the term in the Question 
box of JQuiz

5. Select Multipe-choice from the 
drop-down menu to the right of 
the Question box

6. Enter each choice in a separate 
cell in the Answers column

7. In the Settings column, click on 
“Accept as correct” to indicate the 
correct answer

8. Save the JQuiz file and export as a 

For each Lesson,

1. Select 5-10 glossary terms from 
the Lesson.

2. Find one rhyming word129  and 2-3 
non-rhyming choices per term 

3. Follow steps 3-8 of the 
Development guidelines in A) 
Sounds similar? above to make a 
multiple-choice test

4. Repeat the above for each of the 
other two Lessons in the Module, 
and

5. Repeat for all Modules.

For each Lesson,

1. Select 5-10 glossary terms from 
the Lesson.

2. Find 3-4 rhyming words and one 
which has a different sounding 
ending for each term

3. Follow steps 3-8 of the 
Development guidelines in A) 
Sounds similar? above to make a 
multiple-choice test. The correct 
answer is the word that has 
different sounding ending

4. Repeat the above for each of the 
other two Lessons in the 
Module, and

5. Repeat for all Modules.
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Game

Sounds similar? Rhyming words Spot the not

.htm file

9. Repeat the above for each of the 
other two lessons in the Module, 
and

10. Repeat for all Modules.
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Self-assessment
Once learners have studied sufficiently for the Lesson, as 
described above, it is recommended that they take the respective 
self-assessment and compare their performance with the set goals. 
The existing Educational Games (https://treasurehunt-
games.oikothesis.org/) provide the self-assessment tool and sample 
tests.

If Self-assessment scores are in the “Far:” range of the respective 
End point, learners must review the training material to identify 
weaknesses and take remedial action. 

An additional step in this direction is to prepare Speaking skills 
Educational Games as described in Table 5: Speaking skills 
educational game development plan, above. This step enhances active 
learning and provides additional leverage for improved performance.

The review process and remedial action cycle must continue until 
Self-assessment scores are within the “Near:” range of the End 
point scores.

At that point, learners are considered ready to proceed to the 
Evaluation.

Evaluation
Login to the TREASUREHUNT e-learning platform 
(https://edu.treasurehuntproject.eu/modules). 

If you don’t have an account, sign up for free.

Take the tests in the respective Module and Lesson.

The tests are closed-type questions and they are very similar to 
the Educational Games.

You can interrupt the test-taking and continue later.

Upon successful completion, you will receive a personalized 
certificate of completion for the Module.

Reading skills

Output: 4 Educational Games for reading skills improvement: Letter soup,  Word detective, CluesO, 
Scripting

https://edu.treasurehuntproject.eu/modules
https://treasurehunt-games.oikothesis.org/
https://treasurehunt-games.oikothesis.org/


Table 6: Reading skills educational game development plan

Game

Letter soup Word detective CluesO Scripting

Objective

Improved reading fluency 
skills by recognizing the 
correct sequence of letters in 
a term

Improved reading fluency and 
comprehension skills by 
recognizing the word 
sequence and placing the 
words in the correct order to 
form a sentence

Improved reading 
comprehension skills by 
reading a short text and 
answering the questions 
based on the text, while the 
text is displayed on screen

Improved reading 
comprehension skills at the 
sentence level by placing 
fragments of a  paragraph in 
the correct order to form a 
short cohesive story

Type of questions
Scrambled letters-in-a-term Mixed words in a sentence Multiple choice Paragraph fragment 

sequencing

Hot Potatoes 
application

JMix128 JMix JQuiz129 Sequitur130

Sample tests

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/reading/
5.6.1.R.A-MIX-03.htm

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/reading/
5.6.1.R.B-MIX-04.htm 

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/reading/
5.6.1.R.C-MC.htm

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/reading/
5.6.1.R.D-SEQ.htm

Learner action Rearrange the scrambled 
letters to form a glossary 
term. Clues (definition) 

Rearrange the scrambled 
words to form a complete 
sentence. Clicking on “Hint” 

Read the text displayed and 
use the information in it to 
answer the questions 

Drag and drop paragraph 
fragments to the correct 
order to form a short story. 
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Game

Letter soup Word detective CluesO Scripting

provide additional 
information provided and 
clicking on “Hint” provides the 
next letter in sequence

provides the next word in 
sequence

displayed on the right pane. Learners will have to 
comprehend the meaning of 
fragments and place them in 
the correct order to form a 
short story.

Development 
guidelines

For each Lesson,

1. Select 5-10 glossary 
terms

2. Run the JMix 
Performance monitoring 

3. In the Main sentence 
box, insert one glossary 
term 

4. Press Enter after each 
character, so that each 
character is on a separate 
line

5. Provide a Clue (e.g. 
glossary definition) for 
the term (Options > 

For each Lesson,

1. Select a sentence 
consisting of 5-10 words

2. Run the JMix 
Performance monitoring 

3. In the Main sentence 
box, insert the selected 
sentence

4. Break the sentence into 
words by pressing Enter 
after each word

5. At production time, JMix 
will randomize the order 
of words

For each Lesson,

1. Select a text of 100-200 
words

2. Copy the text to the 
clipboard

3. Run the JQuiz 
Performance monitoring 

4. Insert the selected text 
(File > Add Reading Text > 
Paste in the text box of 
the “Add Reading Text” 
window > OK)

5. In the Question box enter 
the question text

For each Lesson,

1. Select a paragraph of 
100-200 words

2. Copy the text to the 
clipboard

3. Run the Sequitur 
application

4. Insert the selected 
text (File > Import a 
Text File > Paste in the 
text box)

5. Insert breaks at the 
points desired or let 
Sequitur insert breaks 
automatically (Options 
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Configure Output > 
Instructions: > Enter the 
clue)

6. Save the JMix exercise, 
and 

7. Export the output as 
a .htm file. Each time 
the .htm file is run, Hot 
Potatoes will randomize 
the order of letters.

8. Each instance of JMix 
contains one word only, 
thus repeat the above for 
each of the other 
selected words in the 
Lesson

9. Repeat the above for the 
other Lessons in the 
Module

6. Save the JMix exercise, 
and 

7. Export the output as 
a .htm file. Each time 
the .htm file is run, Hot 
Potatoes will randomize 
the order of words.

8. Each instance of JMix 
contains one sentence 
only, thus repeat the 
above for each of the 
other selected sentences 
in the Lesson

9. Repeat the above for the 
other Lessons in the 
Module

6. In the Answers column, 
insert the choices one 
choice per cell

7. In the box next to the 
Question box, click on the 
up or down arrow to 
select “Multiple-choice”

8. Click on the “Accepted as 
correct” checkbox in the 
Settings column to note 
the correct answer

9. Click on the up arrow 
next to Q1, to continue 
adding questions and 
answers to insert as 
many Questions and 
Answers as necessary

10. Save the JQuiz exercise, 
and 

11. Export the output as 
a .htm file

> Auto-break Text and 
enter the number of 
words within a 
segment)

6. Save the Sequitur file, 
and 

7. Export the output as 
a .htm file. Each time 
the .htm file is run, 
Hot Potatoes will 
randomize the order 
of segments.

8. Repeat the above for 
the other Lessons in 
the Module
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12. Repeat the above for the 
other Lessons in the 
Module
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Performance monitoring
Keep track of:

 number if words count in the original text

 how many minutes did it take you to read the entire text?

 how many words did you read? 

 how many words did you omit or skip or forget to read?

 how many mistakes (mispronunciation, etc) did you make?

 how many times did you stop and restart reading a sentence?

 assuming an average native-English speaker reading speed of 
190 correct words (= total words – omitted - 
mispronunciations) per minute, was your reading satisfactory?

Self-assessment
Once learners have studied sufficiently for the Lesson, as 
described above, it is recommended that they take the respective 
self-assessment and compare their performance with the set goals. 
The existing Educational Games (https://treasurehunt-
games.oikothesis.org/) provide the self-assessment tool and sample 
tests.

If Self-assessment scores are in the “Far:” range of the respective 
End point, learners must review the training material to identify 
weaknesses and take remedial action. 

An additional step in this direction is to prepare Reading skills 
Educational Games as described in Table 6: Reading skills 
educational game development plan, above. This step enhances active 
learning and provides additional leverage for improved performance.

The review process and remedial action cycle must continue until 
Self-assessment scores are within the “Near:” range of the End 
point scores.

At that point, learners are considered ready to proceed to the 
Evaluation.

Evaluation
Login to the TREASUREHUNT e-learning platform 
(https://edu.treasurehuntproject.eu/modules). 

https://edu.treasurehuntproject.eu/modules
https://treasurehunt-games.oikothesis.org/
https://treasurehunt-games.oikothesis.org/


If you don’t have an account, sign up for free.

Take the tests in the respective Module and Lesson.

The tests are closed-type questions and they are very similar to 
the Educational Games.

You can interrupt the test-taking and continue later.

Upon successful completion, you will receive a personalized 
certificate of completion for the Module.

Writing skills

Output: 3 Educational Games for reading skills improvement: Spelling bee, Word safari, Note taking
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Table 7: Writing skills educational games development plan131

Game

Spelling bee* Word safari Note taking*

Objective

Improved spelling skills Improved writing skills assessed by 
entering the correct word (in spelling) 
with the correct spelling 

Improved listening and writing skills; 
increased capacity to take notes of 
important points during meetings with 
partners, clients, suppliers, etc.

Type of questions Multiple-choice Fill-in-the-blanks Fill-in-the-blanks

Hot Potatoes application JQuiz JCloze JCloze

Sample tests
https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/writing/5.6.1.W.C-Spell.htm

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/writing/5.6.1.W.B-FIB.htm

https://treasurehunt-
games.oikothesis.org/PR5-HotPot/
EL2/writing/5.6.1.W.A-Dictation.htm

Learner action

Click on the link to listen to the word 
and type in the answer in lowercase in 
the box below. No hints or clues 
provided.

Type in all the missing words in the 
respective blanks. Help provided by 
“Hints”, which give the next letter in a 
word. Some Modules provide clues, 
such as definition of terms.

Learners listen to the recording in 
various speeds to familiarize 
themselves. To take the text, they 
playback at reduced speed and typed-
in the text in the provided boxes.

Development guidelines For each Lesson in a Module, For each Lesson in a Module, For each Lesson in a Module,
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Game

Spelling bee* Word safari Note taking*

1. Select 5-10 terms 

2. Make a recording of each

3. Run the JQuiz Performance 
monitoring 

4. In the Question box, below the 
Title, insert a link to the recording 
of one of the selected terms

5. Select Short-answer from the 
drop-down menu to the right of 
the Question box

6. Select Weighing = 100

7. In the Answers box, enter the 
term

8. Click on the “Accept as correct” 
checkbox in the Settings column 
to note the correct answer

9. Click on the little black up arrow 
next to Q1, to continue adding 
questions (links to the audio 

1. Select a 50-100 word text 
segment. Each select sentence 
must contain one glossary term. 
If a sentence does not contain a 
term, skip it.

2. Enter the text to the JCloze tool.

3. Select 10-15 terms from the text 
and blank them.132

4. When you click on the Gap 
button, JCloze will ask if you 
want to insert a Clue or 
Alternative correct answers. It is 
recommended to enter a Clue, 
and Alternative correct 
answer(s), if applicable.133

5. In the JCloze > Titles/Instructions 
tab, “Exercise subtitle:” and the 
“Instructions:” panes, provide 
instructions. 

6. Save the JCloze file and export it 

1. Select a text of 100-200 words

2. Copy the text to the clipboard

3. Run the JCloze Performance 
monitoring 

4. Insert the selected text (File > 
Add Reading Text > Paste in the 
text box of the “Add Reading 
Text” window > OK)

5. In the JCloze window displaying 
the inserted text, break the text 
to appropriate segments 
according to size and meaning, 
i.e. not too many words per 
segment and possibly each 
segment having its own 
independent meaning. 
Alternatively, you may chose to 
let JCloze break the segment 
automatically 

6. Use ttsmaker.com to make a 
recording of the text in normal, 
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Spelling bee* Word safari Note taking*

recording of each term) and 
answers

10. Repeat the above for the rest of 
the selected terms

11. Click Options > Mode > Advanced 
mode

12. Save the JQuiz exercise, and 

13. Export the output as a .htm file

14. Repeat the above for the other 
Lessons in the Module, and the 
six Modules of PR4.

as .htm file 

7. Repeat the above for the other 
two Lessons in the Module, and 
each of the six Modules in PR4.

reduced and slow speeds; make 
sure that you insert breaks at the 
text break points

7. Click Options > Configure Output 

8. In the Titles/Instructions tab, 
click on Instructions: to enter the 
appropriate links to the audio 
files and possible instructions to 
the end-user (See sample tests, 
above)

9. Click OK

10. Save the .jcl file, and 

11. Export the output as a .htm file

12. Repeat the above for the other 
Lessons in the Module

* This test combines listening and writing skills; learners will listen to the audio recording of single 
terms or segments, and will have to type in each item on screen.
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Self-assessment
Once learners have studied sufficiently for the Lesson, as 
described above, it is recommended that they take the respective 
self-assessment and compare their performance with the set goals. 
The existing Educational Games (https://treasurehunt-
games.oikothesis.org/) provide the self-assessment tool and sample 
tests.

If Self-assessment scores are in the “Far:” range of the respective 
End point, learners must review the training material to identify 
weaknesses and take remedial action. 

An additional step in this direction is to prepare Writing skills 
Educational Games as described in Table 7: Writing skills 
educational games development plan, above. This step enhances 
active learning and provides additional leverage for improved 
performance.

The review process and remedial action cycle must continue until 
Self-assessment scores are within the “Near:” range of the End 
point scores.

At that point, learners are considered ready to proceed to the 
Evaluation.

Evaluation
Login to the TREASUREHUNT e-learning platform 
(https://edu.treasurehuntproject.eu/modules). 

If you don’t have an account, sign up for free.

Take the tests in the respective Module and Lesson.

The tests are closed-type questions and they are very similar to 
the Educational Games.

You can interrupt the test-taking and continue later.

Upon successful completion, you will receive a personalized 
certificate of completion for the Module.

Vocabulary skills

For some hints on how to practice Vocabulary Skills, refer to Flashcards, In: How to construct your 
own exercises and tests, p. 4134

https://edu.treasurehuntproject.eu/modules
https://treasurehunt-games.oikothesis.org/
https://treasurehunt-games.oikothesis.org/


Table 8: Vocabulary skills educational games development plan

Game

TermID Lord of the Words Matchmaker Crossword

Objective

Improved vocabulary skills by 
reinforcing association 
between an English term and 
its English definition.

Improved vocabulary skills by 
recognizing words even when 
letters are in random order.

Improved vocabulary skills by 
recognizing the meaning of 
the term and using it within 
sentences.

Improved vocabulary skills 
and term identification by its 
term and use in an out-of-
sentence environment.

Type of questions Match-type Jumbled letters Fill-in-the-blanks Crossword puzzle

Hot Potatoes 
application

JMatch JMix JCloze JCross

Sample tests

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/vocabulary/
5.6.1.V.A-MATCH.htm

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/vocabulary/
5.6.1.V.B-MIX-04.htm

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/vocabulary/
5.6.1.V.C-FIB.htm

https://treasurehunt-
games.oikothesis.org/PR5-
HotPot/EL2/vocabulary/
5.6.1.V.D-CW.htm

Learner action Drag the English definition 
next to the corresponding 
English term

Drag and drop each letter to 
the correct position to form a 
glossary term. Learners can 
open the next letter by 
clicking on the “Hint” button. 
No other clues (definitions) 

Match terms and sentences 
and fill-in-the-blanks by 
selecting the appropriate 
term from the drop-down 
menu next to the blanks

Solve the crossword puzzle. 
Clues provide identification 
information (definition) of a 
term, “Hint” provides the 
next letter.
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Game

TermID Lord of the Words Matchmaker Crossword

provided.

Development 
guidelines

For each Lesson in a Module,

1. Select 5-10 terms.

2. Use the TREASUREHUNT 
project agritourism 
glossary135 to find the 
English definition of each 
term. 

3. Run the JMatch program

4. Insert each term in a 
separate cell of the left 
column of JMatch. 

5. Insert the matcing 
definitions of term in the 
cells of the right column 
of JMatch.

6. Save the JMatch file and 
output to .htm file.

For each Lesson in a Module,

1. Select 5-10 glossary 
terms

2. Run the JMix program

3. In the Main sentence 
box, insert one glossary 
term 

4. Press Enter after each 
character, so that each 
character is on a separate 
line

5. Save the .jmx file, and 

6. Export the output as 
a .htm file. Each time 
the .htm file is run, Hot 
Potatoes will randomize 
the order of letters

7. Each instance of JMix 

For each Lesson in a Module,

1. Select a 100-200 word 
text segment. Each 
sentence of the selected 
segment must contain 
one glossary term. If a 
sentence does not 
contain a term, skip it; it 
will not cause much 
harm. The final text must 
contain 10-12 glossary 
terms.

2. Copy the text to the 
clipboard.

3. Run the JCloze program

4. Insert the text to the 
JCloze (File > Add Reading 
Text > Paste).

For each Lesson in a Module,

1. Select 15-20 terms

2. Copy these terms one 
term per line to the 
clipboard.

3. Run the JCross program 
of Hot Potatoes

4. Click on Manage Grid > 
Automatic Grid-Maker

5. In the “Create a 
crossword grid 
automatically” frame, 
paste the list of terms 
on the left box

6. Click on “Make the grid” 
button

7. On the main screen of 
JCross, click on the “Add 
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7. Repeat the above for the 
other two Lessons in the 
Module, and each of the 
six Modules in PR4.

contains one word only, 
thus repeat the above for 
each of the other 
selected words in the 
Lesson

8. Repeat the above for the 
other Lessons in the 
Module

5. In the main screen of 
JCloze, blank each one of 
the 10-12 terms.136

6. When you click on the 
Gap button, JCloze will 
ask if you want to insert a 
Clue or Alternative 
correct answers. Do not 
add any Clues137, but add 
alternative answers (e.g. 
Agritourism and 
Agrotourism), if 
applicable.

7. In the JCloze > 
Titles/Instructions tab, 
“Exercise subtitle:” and 
the “Instructions:” panes, 
provide instructions. 

8. Save the JCloze file and 
export it as .htm file 

9. Repeat the above for the 

Clues” button

8. Add each clue to the 
respective term

9. Save the .jsw file, and 

10. Export the output of it 
as .htm file

11. Repeat the above for 
the other two Lessons in 
the Module and each of 
the six Modules in PR4.
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other two Lessons in the 
Module, and each 
Module in PR4.
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Self-assessment
Once learners have studied sufficiently for the Lesson, as 
described above, it is recommended that they take the respective 
self-assessment and compare their performance with the set goals. 
The existing Educational Games (https://treasurehunt-
games.oikothesis.org/) provide the self-assessment tool and sample 
tests.

If Self-assessment scores are in the “Far:” range of the respective 
End point, learners must review the training material to identify 
weaknesses and take remedial action. 

An additional step in this direction is to prepare Vocabulary 
skills Educational Games as described in Table 8: Vocabulary skills
educational games development plan, above. This step enhances 
active learning and provides additional leverage for improved 
performance.

The review process and remedial action cycle must continue until 
Self-assessment scores are within the “Near:” range of the End 
point scores.

At that point, learners are considered ready to proceed to the 
Evaluation.

Evaluation
Login to the TREASUREHUNT e-learning platform 
(https://edu.treasurehuntproject.eu/modules). 

If you don’t have an account, sign up for free.

Take the tests in the respective Module and Lesson.

The tests are closed-type questions and they are very similar to 
the Educational Games.

You can interrupt the test-taking and continue later.

Upon successful completion, you will receive a personalized 
certificate of completion for the Module.

https://edu.treasurehuntproject.eu/modules
https://treasurehunt-games.oikothesis.org/
https://treasurehunt-games.oikothesis.org/
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https://uklp.com/adults-better-learning-languages-children/
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https://www.sciencedirect.com/science/article/abs/pii/S0010027718300994
https://www.leonardoenglish.com/blog/the-simple-guide-to-english-word-order#toc-10
https://www.britishcouncil.org/voices-magazine/babies%E2%80%99-language-learning-can-help-adult-learners
https://www.onepeloton.com/blog/how-long-does-it-take-to-form-a-habit/
https://www.youtube.com/watch?v=P6FORpg0KVo
https://www.youtube.com/watch?v=UdsUVjeJuPE
http://dx.doi.org/10.5772/intechopen.95219
https://www.oxfordlearnersdictionaries.com/external/pdf/wordlists/oxford-3000-5000/The_Oxford_3000.pdf
https://rm.coe.int/CoERMPublicCommonSearchServices/DisplayDCTMContent?documentId=090000168045bb52
https://www.thetreetop.com/statistics/average-human-attention-span
https://www.theguardian.com/lifeandstyle/2018/oct/14/the-lost-art-of-concentration-being-distracted-in-a-digital-world
https://www.theguardian.com/lifeandstyle/2018/oct/14/the-lost-art-of-concentration-being-distracted-in-a-digital-world
https://economictimes.indiatimes.com/tech/internet/heres-how-technology-affects-our-life/technology-addiction/slideshow/62497145.cms
https://economictimes.indiatimes.com/tech/internet/heres-how-technology-affects-our-life/technology-addiction/slideshow/62497145.cms
https://www.ethnos.gr/Politics/article/102098/ypotheshskoilelikikoytoparaskhniopisoapotofiaskothsthlekatartishs
https://www.theverge.com/2023/11/21/23971489/openai-chatgpt-voice-feature-ceo-drama
https://www.youtube.com/watch?v=fM6sOUylrM0


33 Anderman, E. M. and Dawson, H. 2011. The Intrinsic/Extrinsic Motivation Debate. Chapter 11: Learning with 
Motivation. In: Handbook of Research on Learning and Instruction. Mayer, R. E. and Alexander P. A. (eds.). Taylor & 
Francis, New York, NY. pp: 219-241. 
(https://www.researchgate.net/profile/Hadley-Solomon/publication/257947063_Learning_with_Motivation/
links/574b189408ae2e0dd301a04c/Learning-with-Motivation.pdf)

34 “a range of formal and informal assessment procedures conducted by teachers during the learning process in 
order to modify teaching and learning activities to improve learner academic performance”. Wikipedia: formative 
assessment. Last accessed: 6/7/2024. 

Bennett, R.E., 2011. Formative assessment: A critical review. Assessment in education: principles, policy & 
practice, 18(1), pp.5-25.

Black, P. and Wiliam, D., 2009. Developing the theory of formative assessment. Educational Assessment, 
Evaluation and Accountability (formerly: Journal of personnel evaluation in education), 21, pp.5-31.

Popham, W.J., 2006, September. Defining and enhancing formative assessment. In Annual Large-Scale Assessment 
Conference, Council of Chief State School Officers, San Francisco, CA.

35 for example, https://cd.oikothesis.org/lesson/Know-your-customer-23  #Exercises  

36 https://cd.oikothesis.org/home-page-1   #Award-winning training tool

37 https://www.crauswords.com/   

38 https://www.youtube.com/watch?v=i4w521XBsQQ  

39 https://en.wikipedia.org/wiki/Machine_learning   

40 For example, Google Translate (https://translate.google.com/), Microsoft Translator 
(https://www.bing.com/translator), DeepL (https://www.deepl.com/en/translator), etc.

41 In 2020, a Greek Minister of Education was forced to resign for not checking machine translated manuals and 
escaped transliteration sequences.

42 In the US, the term “learning coaches” refers to individuals cooperating and helping professionally school teachers 
to achieve their class achievement goals. For the purposes of the TREASUREHUNT project, the term “learning 
coaches” refers to teachers advising, teaching or “coaching” project Target groups.

43 https://learnenglishteens.britishcouncil.org/skills   

44 http://hotpot.uvic.ca/   

45 A Google search for “Hot Potatoes” resulted in 4.65 million hits; last access: 17/11/2023.

46 For Hot Potatoes example exercises, visit https://hotpot.uvic.ca/wintutor7/tutorial.htm # The Potatoes, one by 
one.

47 https://cd.oikothesis.org/media/source/Teacher%20Training/How%20to%20construct%20your%20own  
%20exercises%20and%20tests/How%20to%20construct%20your%20own%20exercises%20and%20tests-
formatted.pdf 

48 https://www.educationcorner.com/study-location/   

49 https://www.nytimes.com/2010/09/07/health/views/07mind.html   

50 Anki (https://apps.ankiweb.net/) is a great free, open source and highly customizable tool for spaced repetition. 
Essentially, it is a flashcard simulation that greatly improves memory retention. It can be used to remember 
anything, anywhere. Runs of Windows, Mac and Linux. Download from: https://apps.ankiweb.net/#Downloads

51 See Appendix 4 – Good writing practices.

52 https://amp.theguardian.com/sport/2023/may/31/scripps-national-spelling-bee-international   

53 For some  general ideas on how to teach vocabulary, visit https://www.nytimes.com/2021/10/19/learning/live-
webinar-teaching-vocabulary-with-the-new-york-times.html?pgtype=Article&action=click&module=RelatedLinks 

54 Daily or weekly rotation or randomized order, but always keeping the 4+1 number of skills per day

55 Appendix 3 – AI enhancements

56 https://www.usa.edu/blog/study-techniques/  , 

https://www.futurelearn.com/info/blog/top-study-tips-for-effective-learning,

https://greator.com/en/learning-tips/ 

https://greator.com/en/learning-tips/
https://www.futurelearn.com/info/blog/top-study-tips-for-effective-learning
https://www.usa.edu/blog/study-techniques/
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https://www.researchgate.net/profile/Hadley-Solomon/publication/257947063_Learning_with_Motivation/links/574b189408ae2e0dd301a04c/Learning-with-Motivation.pdf
https://www.researchgate.net/profile/Hadley-Solomon/publication/257947063_Learning_with_Motivation/links/574b189408ae2e0dd301a04c/Learning-with-Motivation.pdf


https://www.vu.edu.au/about-vu/news-events/study-space/10-tips-on-how-to-study-effectively 

57 https://www.nytimes.com/2010/09/07/health/views/07mind.html   

58 https://www.youtube.com/watch?v=tkm0TNFzIeg  

59 https://www.youtube.com/watch?v=q-16DPh_VWw  

60 https://www.forbes.com/sites/quora/2017/11/08/what-makes-chunking-such-an-effective-way-to-learn/   

61 https://www.youtube.com/watch?v=HAnw168huqA  

62 http://www.chrest.info/fg/papers/Chunking-TICS.pdf  

63 https://tlconestoga.ca/content-chunking/   

64 https://www.verywellmind.com/chunking-how-can-this-technique-improve-your-memory-2794969  

65 https://link.springer.com/referenceworkentry/10.1007/978-1-4419-1428-6_1042  

66 https://www.edutopia.org/article/chunking-content-classroom/  

67 https://selfcontrolapp.com/  

68 https://www.focalfilter.com/  

69 for example, https://www.youtube.com/watch?v=mNBmG24djoY

70 https://www.youtube.com/watch?v=5WRO79zuJ4U  

71 https://www.projectlibre.com/product/1-alternative-microsoft-project-open-source   

72 Adapted from Mansoor, I., 2002. Tips on searching the internet for medical information. Journal of Family and 
Community Medicine, 9(1), pp.57-61. (https://www.ncbi.nlm.nih.gov/pmc/articles/PMC3430177/)

73 https://support.microsoft.com/en-us/office/use-the-speak-text-to-speech-feature-to-read-text-aloud-459e7704-  
a76d-4fe2-ab48-189d6b83333c 

74 https://www.getpronounce.com/  

75 Learners can also take note of the suggested video list on the right hand side of the browser.

76 Some of these tools are really impressive in that they can respond with a natural-sounding voice (including filler 
words, breathing between words and intonation!), or speaking in the first person-pretending they are real people-, 
or the answers they can provide to all sorts of hypothetical and strange questions. However, not all of these tools 
are currently available in all countries, and they will probably require a paid subscription to the AI tool, not just the 
free version.

77 https://www.youtube.com/watch?v=3mNNj_noocA  

78 https://theresanaiforthat.com/s/chatbots/?sort=default   

79 https://medium.com/@linguatrip/how-to-use-artificial-intelligence-to-learn-english-4dc4dccbccb   

80 https://www.youtube.com/watch?v=kXChJfHZrjU   

81 For a list of methods for ChatGPT voice control, visit https://www.makeuseof.com/ways-to-control-chatgpt-with-
voice/ 

82 https://americanenglish.state.gov/files/ae/resource_files/dialogs_for_everyday_use_508.pdf   

83 https://www.youtube.com/watch?v=sXOAanKbXAQ   

84 https://www.youtube.com/watch?v=LzEZRvk0Bqg  

85 https://www.youtube.com/watch?v=cJjsgI9sVYc   

86 https://www.futuretools.io/  

87 https://www.producthunt.com/   

88 https://theresanaiforthat.com/   

89 https://www.youtube.com/watch?v=58xKrH1-IaY   

90 https://www.youtube.com/watch?v=DOGm2wmJrE0   

91 https://ttsmaker.com/   

92 https://www.canva.com/apps/AAFlnMQm--8/murf-ai   

93 https://buzzcaptions.com/   
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94 https://openai.com/research/whisper   

95 https://convertspeech.com/   

96 https://elsaspeak.com/en/   

97 https://www.speechace.com/    -  instant score on subjects of: reporting on pronunciation, fluency, vocabulary, 
grammar scores, report generation by subject; no free trial; fixed material, no entry of other text.

98 LLM is a type of language model notable for its ability to achieve general-purpose language understanding and 
generation. (https://en.wikipedia.org/wiki/Large_language_model; last access: 10/11/2023). Notable examples 
include OpenAI's GPT models (e.g., GPT-3.5 and GPT-4, used in ChatGPT), Google's PaLM (used in Bard), and 
Meta's LLaMa, as well as BLOOM, Ernie 3.0 Titan, and Anthropic's Claude 2. 

99 https://medium.com/mlearning-ai/the-chatgpt-list-of-lists-a-collection-of-1500-useful-mind-blowing-and-strange-  
use-cases-8b14c35eb ,
https://www.semrush.com/blog/chatgpt-prompts/ 

100 https://www.icls.edu/blog/video-games-help-people-to-learn-a-new-language   

101 Chen, H. J. H., & Yang, T. Y. C. (2012). The impact of adventure video games on foreign language learning and the 
perceptions of learners. Interactive Learning Environments, 21(2), 129–141. 
https://doi.org/10.1080/10494820.2012.705851 

102 https://quizlet.com/  

103 https://qz.app.do  

104 https://www.merriam-webster.com/games  

105 https://www.facebook.com/games/instantgames/category/?  
category=953400792157137&store_visit_source=categories_lhc

106 https://www.fluentu.com/blog/english/games-to-learn-english/  

107 https://en.wikipedia.org/wiki/The_New_York_Times_Games  ; last accessed: 19/06/2024

108 https://games.washingtonpost.com/category/word   

109 https://www.latimes.com/games   

110 https://www.nytimes.com/puzzles/spelling-bee   

111 https://www.theguardian.com/crosswords   

112 https://www.theguardian.com/commentisfree/2023/feb/14/how-am-i-spending-early-middle-age-playing-  
phrazle-and-other-mesmerising-word-games 

113 https://www.theguardian.com/games/2022/feb/28/worldle-sweardle-byrdle-a-guide-to-the-maze-of-word-game-  
apps-that-arent-wordle

114 https://americanenglish.state.gov/files/ae/resource_files/etf_54-4_pg14-23.pdf   

115 Odo, Dennis Murphy. "Crowdsourced Language Learning: Lessons for TESOL Educators from Online Language-
Learning Enthusiasts." English Teaching Forum. Vol. 54. No. 4. US Department of State. Bureau of Educational and 
Cultural Affairs, Office of English Language Programs, SA-5, 2200 C Street NW 4th Floor, Washington, DC 20037, 
2016. (https://americanenglish.state.gov/files/ae/resource_files/etf_54-4_pg14-23.pdf)

116 A Wright, D Betteridge, M Buckby (2006) Games for language learning. p. 11 (books.google.com) 

117 For instructions on how to make matching exercises using the JMatch application of Hot Potatoes, visit 
https://hotpot.uvic.ca/wintutor7/tutorial.htm # Introduction to JMatch (matching exercises), 
https://hotpot.uvic.ca/hotpot7_help.pdf p. 28, 

For an example of Matching Exercise, visit https://hotpot.uvic.ca/wintutor7/jmatch2.htm.

To see how the scoring works for JMatch, visit https://hotpot.uvic.ca/hotpot7_help.pdf, p. 32, “How does the 
scoring work in the other applications”

For help, click on the Help menu.

In addition, see https://hotpot.uvic.ca/hotpot7_help.pdf, JMatch section, p. 28

118 For help, click on the Help menu.

In addition, see https://hotpot.uvic.ca/hotpot7_help.pdf, JCloze section, p. 23
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119 The audio files must be in the same directory as the source (.jmt) files.

120 In JMatch, click on Insert > Link > Link to a Local File. Make sure that the .mp3 files and the Hot Potatoes source file 
are in the same directory.

121 In JCloze, select the term and hit the “Gap” button.

122 To create a link to an .mp3 file, in an empty space of the JCloze input window, click on Insert > Link > Link to a Local 
File and select the .mp3 file. Make sure that the .mp3 files and the Hot Potatoes source file are in the same 
directory.

Select the link and move it to the “Exercise subtitle:” or the “Instructions:” pane. 

123 https://TreasureHuntproject.eu/  

124 The learning-by-raw-power way is to replay the same paragraph until learners have learned it by heart and they 
can recite it without looking at the text. However, this may not be necessary and learners are expected devise 
more efficient learning ways. For example, learners can invent jokes to help them memorize the text.

125 For instructions on how to make multiple choice question exercises in Hot Potatoes using JQuiz, visit 

https://hotpot.uvic.ca/wintutor7/tutorial.htm # Introduction to JQuiz (question-based exercises) and click through 
Go!Three steps in making an exercise, etc.

For an example of a quiz made with JQuiz, visit https://hotpot.uvic.ca/wintutor7/jquiz1.htm, and to see examples 
of all four JQuiz question types, visit https://hotpot.uvic.ca/wintutor7/jquiz2.htm 

To see how the JQuiz scoring works, visit https://hotpot.uvic.ca/hotpot7_help.pdf, p. 32, “How does the scoring 
work in the other applications”

126 Homophones are two or more words that sound alike, but have different meanings and spelling; for example, new 
and knew, hair and hare, etc.

Rhyming words are words that have similar sounding endings; for example, gravel and travel, light and flight, etc.

Obviously, there are many more rhyming words compared to homophones.

127 To find homophones, rhyming words, etc. visit the following sites and search for “Find rhymes”

https://www.rhymezone.com/r/rhyme.cgi?org1=syl&org2=l&typeofrhyme=sim&Word=business 

https://www.rhymezone.com/r/rhyme.cgi?Word=Stick&org1=syl&org2=l&org3=y&typeofrhyme=sim 

http://www.singularis.ltd.uk/bifroest/misc/homophones-list.html 

https://www.merriam-webster.com/grammar/homophones-vs-homographs-vs-homonyms 

https://accenteraser.com/blog/homophones/ 

https://www.onelook.com/ 

128 For an example of a mixed-up word exercise made with the JMix program of Hot Potatoes, visit 
https://hotpot.uvic.ca/wintutor7/jmix1.htm and https://hotpot.uvic.ca/wintutor7/jmix2.htm

For instructions on how to make exercises with JMix, visit https://hotpot.uvic.ca/wintutor7/tutorial.htm and click 
on “Go! JMix (jumble exercises)”.

For the scoring algorithm of JMix exercises, visit https://hotpot.uvic.ca/hotpot7_help.pdf, p. 32, “How does the 
scoring work in the other applications?”

129 In principle, this is a similar exercise to the Letter soup one. For Help, see footnote 132, below, and substitute 
“letter” with “word” and “word” with “sentence”.

130 WebSequitur is part of the TexToys suite. Download TexToys from http://www.cict.co.uk/textoys/sequitur.php and 
install in on your PC

131 For some tips & rules for answering IELTS essay questions, visit https://www.youtube.com/watch?v=yle3Wytf_LE, 
https://www.youtube.com/watch?v=yvt8RzGNhBc, etc.

132 In JCloze, select the term and hit the “Gap” button.

133 For example, Agritourism and Agrotourism

134 https://cd.oikothesis.org/media/source/Teacher%20Training/How%20to%20use%20the%20extra%20material/  
How%20to%20use%20the%20Extra%20Material-formatted.pdf 

135 https://treasurehuntproject.oikothesis.org/   

https://treasurehuntproject.oikothesis.org/
https://cd.oikothesis.org/media/source/Teacher%20Training/How%20to%20use%20the%20extra%20material/How%20to%20use%20the%20Extra%20Material-formatted.pdf
https://cd.oikothesis.org/media/source/Teacher%20Training/How%20to%20use%20the%20extra%20material/How%20to%20use%20the%20Extra%20Material-formatted.pdf
https://www.youtube.com/watch?v=yvt8RzGNhBc
https://www.youtube.com/watch?v=yle3Wytf_LE
http://www.cict.co.uk/textoys/sequitur.php
https://hotpot.uvic.ca/hotpot7_help.pdf
https://hotpot.uvic.ca/wintutor7/tutorial.htm
https://hotpot.uvic.ca/wintutor7/jmix2.htm
https://hotpot.uvic.ca/wintutor7/jmix1.htm
https://www.onelook.com/
https://accenteraser.com/blog/homophones/
https://www.merriam-webster.com/grammar/homophones-vs-homographs-vs-homonyms
http://www.singularis.ltd.uk/bifroest/misc/homophones-list.html
https://www.rhymezone.com/r/rhyme.cgi?Word=Stick&org1=syl&org2=l&org3=y&typeofrhyme=sim
https://www.rhymezone.com/r/rhyme.cgi?org1=syl&org2=l&typeofrhyme=sim&Word=business
https://hotpot.uvic.ca/hotpot7_help.pdf
https://hotpot.uvic.ca/wintutor7/jquiz2.htm
https://hotpot.uvic.ca/wintutor7/jquiz1.htm
https://hotpot.uvic.ca/wintutor7/tutorial.htm
https://treasurehuntproject.eu/


136 In JCloze, select the term and hit the “Gap” button.

137 The lack of Clues, such as definitions or other term identification, makes this a hard test to take. Learners 
preparing their own Games and learning coaches preparing the Games for students may want to amend this and 
add additional information, such as Clues, to make the test easier.


